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CHAPTER 1

Introduction
Supported In:

You can use the search feature in online outputs. Search works differently with each output
type. There are also special features that you can use to enhance search, such as micro content,
synonyms, partial-word search, filters, reports, and excluding topics from search.

General Information

n "Client or Server Output" on page 10

n "Searching the Outputs" on page 11

n "End User Search Features" on page 38

n "Content Developer Search Options" on page 40

Required Activities

n "Including Search Bars" on page 43

n (HTML5 Only) "Setting Up a Search Engine" on page 49

l "MadCap Search" on page 55

l "Elasticsearch" on page 60

l "Google Search" on page 128
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Optional Activities

n "Setting Search Results Options" on page 134

n "Generating Sitemaps" on page 166

n "Optimizing Search" on page 168

n "Search Filter Sets" on page 207

n "Search Highlighting" on page 226 and "Customizing the Highlight Color for Search Hits" on
page 229

n "Server-Based Search HTML5" on page 237

n "Creating Synonyms" on page 260

n "Including or Excluding Topics in Search" on page 267
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CHAPTER 2

General Information for Search
There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Client or Server Output 10

Searching the Outputs 11

End User Search Features 38

Content Developer Search Options 40
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Client or Server Output
The search features and capabilities that are available in your published Flare output depend on the
output type. In addition, you can perform search queries using different search methods and syntax
when you publish client- or server-based output:

n Search and Client-Based Output With the web-based output types, search operations are
supported by a Flare search database. This database consists of an array of JavaScript and
XML files that are built and published with the Flare output in the Data folder. With Microsoft
HTML Help, the Microsoft Compiled HTML (CHM) Help file format also offers a built-in search
engine.

n Search and Server-Based Output There are multiple search options to choose from for online
output, including server-based search options. For example, the server-based HTML5 output
type can be enabled in Flare, and then published to an Internet Information Services (IIS)
server. For these outputs, search operations are supported by the Microsoft Indexing Service
or Windows Search.

However, you do not need to use HTML5 server-based output to have server-based search.
We recommend that you use Elasticsearch with regular HTML5 output to produce server-
based search. Elasticsearch includes features such as search auto-complete with
suggestions.
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Searching the Outputs
Depending on the output type, the user interface for your published output offers different search
features and functionality.

When compiling online output, the build process generates a search database with the target's
output files. When an end user searches for information, the search process looks through this
database to retrieve a list of topics containing matching criteria.

NOTE End user search features are supported by the Eclipse Help Viewer and search
operations are provided by a plug-in that you develop using the Eclipse platform (for more
information, see help.eclipse.org). The Flare search engine does not handle Eclipse Help
search operations.

Searching an HTML5 System
End users have a variety of options when performing a search in an HTML5 system.

Search Experience
An HTML5 skin provides the user interface for an HTML5 system. When an end user searches an
HTML5 system for information, it reveals a list of topics containing the matching term or phrase.
The search results show the topic title and the topics are listed in ranked order. The results also
include an excerpt of the paragraph text from the topic (or you can opt to use the meta description
that you add to the topic properties). This helps users decide if the page contains the information
they were looking for. When a user clicks a topic to open it, the matching terms are highlighted in
the topic.

CHAPTER 2  11

http://help.eclipse.org/


CHAPTER 2  12



Features and Capabilities
This table details the search features and capabilities of the HTML5 system. It also describes the
options that you have for customizing the user interface:

Feature Description Content Developer Options

Search Field and
Button

Type a search query. Then click the
button or press ENTER to initiate a
search.

NOTE Asterisk (*) wildcard
and boolean search
capabilities are available.
See "Search Methods and
Syntax" on page 27.

Change the look of the field and
button.

Filters List Provides users with the ability to
narrow the scope of their search
results to categories defined by a
search filter set.

Create filter selections by adding a
search filter set and associating it
with the Flare target. See "Creating
Search Filters" on page 216 and
"Associating a Search Filter Set
With a Target" on page 220.

Customize the order of the search
filters in the output. See
"Customizing Search Filter
Ordering" on page 218.

Change the appearance of the
drop-down in the Skin Editor.
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Feature Description Content Developer Options

Search Results Lists search results in ranked
order.

Matching keywords are bolded in
search results.

Change the appearance of your
search results.

Set the number of search results
that display on each page. See
"Optimizing a Site" on page 194.

Adjust the weight the search
engine places on internal links to a
topic when ranking search results.
See "Setting Search Result
Importance" on page 146.

If you are using Pulse, you have the
option to display community
results in search. 

Search
Highlighting

Highlights matching keywords in
topics.

Tripane output shows highlights
words in color by default. In Side
and Top Navigation outputs,
search results are transparent, but
you can customize this, adding
colors.

NOTE Matches are not
highlighted when users
perform searches with the
asterisk (*) wildcard
character.

Define the highlight color in the
project's stylesheet. See
"Search Highlighting" on page 226.

Remove
Highlighting
Button

Removes search highlighting from
topics.

Include this button in the toolbar.
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Feature Description Content Developer Options

Search Result
Pagination
Options

Change the number of search
results that appear on the page.

Include and format pagination
options.

Search Non-
HTML Files

(Server-Based
Output Only)

When end users perform a search
in your online output, you can
ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that
search.

Include non-HTML files in search
results when publishing server-
based output. See "Including Non-
XHTML Files in HTML5 Search" on
page 254.
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How to Search
1. Open the HTML5 system.

2. In the search field, type the search query. Then click the Search button or press Enter.

NOTE Searches are not case-sensitive. See "Search Methods and Syntax" on page
27.

NOTE If a search filter set is added to the project, users can narrow the scope of the
search by selecting an item from the Filter list. This limits the scope to search only
the topics assigned to the selected filter. See "Search Filter Set Example" on page
221.

3. In the search results list, double-click one of the topics to open it. Search highlighting reveals
the matches in the topic.

NOTE The search highlighting colors can be customized by the content developer.
See "Customizing the Highlight Color for Search Hits" on page 229.

NOTE If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.
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Searching a Microsoft HTML Help System
End users have a variety of options when performing a search in a Microsoft HTML Help system.

Search Experience
A Standard skin provides the user interface for a Microsoft HTML Help system. It also includes
features defined by the Compiled HTML (CHM) specification.

When an end user searches a Microsoft HTML Help system for information, it reveals a list of
topics containing the matching term or phrase. The search results shows matches by title, location,
and rank. When an end user clicks a topic to open it, the matching terms are highlighted in the
topic.
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Features and Capabilities
This table details the search features and capabilities of the Microsoft HTML Help system. It also
describes the options that you have for customizing the user interface:

Feature Description Content Developer Options…

Search Tab A tab that reveals the search
feature.

Enable the search feature using
the Skin Editor. See "Including
Search Bars" on page 43.

Search Field and
Button

Type a search query. Then click
the button or press ENTER to
initiate a search.

NOTE Asterisk
(*) wildcard and boolean
search capabilities are
available. See "Search
Methods and Syntax" on
page 27.

Cannot be turned on and off.

Boolean Operators List A drop-down list of boolean
operators that can be used with
search.

Cannot be turned on and off.

Supports the listed boolean
operators only. See "Search
Methods and Syntax" on page
27.

Advanced Search
Check Boxes

A series of three advanced search
check boxes:

n Search previous results

n Match similar words

n Search titles only

Enable or disable these options
in the Skin Editor by clicking the
HTML Help Setup tab. Under
MiscOptions, place a check
mark in theShow Advanced
Search box.
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Feature Description Content Developer Options…

Search Results Lists search results in ranked
order.

Cannot be turned on and off.

Optimize topics to improve
search results. See "Optimizing
Search" on page 168.

Display Button Opens the highlighted topic. End
users can alternatively double-
click a topic to open it.

Cannot be turned on and off.

Search Highlighting Highlights matching keywords in
topics.

Cannot modify search highlight
color.
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How to Search
1. Open the Microsoft HTML Help system.

2. In the navigation pane, click the Search tab.

3. Type the search query. Then click List Topics or press ENTER.

NOTE Searches are not case-sensitive. See "Search Methods and Syntax" on page
27.

NOTE The search query can include boolean operators or the asterisk (*) wildcard
character. See "Search Methods and Syntax" on page 27.

TO USE THE ADVANCED SEARCH OPTIONS

If you enabled the Advanced Search check boxes, users have option to refine the search
query as follows:

n Search Previous Results If you want to search only the topics included in the previous
results list, place a check mark in theSearch previous results box.

n Match Similar Words To find words with similar spelling, place a check mark in
theMatch similar wordsbox. For example, if you type puppy and select this check box,
the search finds "puppy" and "puppies."

n Search Titles Only To search topics only for matches in the topic title, place a check
mark in theSearch titles only box.
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4. In the search results, open the desired topic using one of these methods:

n Highlight a topic in the list. Then click Display.

n Double-click a topic in the list. Search highlighting reveals the matches in the topic.

NOTE If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.

NOTE Unlike other output types, you cannot modify the search highlighting color in
Microsoft HTML Help. See "Search Highlighting" on page 226.

Troubleshooting the No Topics Found Issue
A common issue encountered by Microsoft HTML Help developers is when a "No Topics Found"
message appears while searching a CHM file.

Typically, this is the result of an unregistered dynamic link library (DLL) file on the computer building
the Help file. The DLL is named "itcc.dll" and is a component of Microsoft's CHM specification. Its
purpose is to supply the operating system running Flare with the ability to build a CHM file with
index and search capabilities.

A variety of software vendors (particularly those that develop Help authoring tools) distribute a
copy of the itcc.dll file along with their program installation files. Should you happen to install or
uninstall program with a copy of this file (e.g., a Help tool or software program from another vendor
or another MadCap software tool that requires this file), it is possible for other copies of the itcc.dll
file to become unregistered.

To resolve this issue, the Flare \bin directory contains a batch file named RegisterItcc.bat. You can
run this batch file to re-register the DLL in Windows.

NOTE Users running Windows 7 may need to switch off the computer's User Account
Control (UAC) settings before beginning. For instructions, visit this link:

http://windows.microsoft.com/en-us/windows7/products/features/user-account-
control
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How to Register the DLL Using the Batch File

1. In Windows Explorer, navigate to the Flare installation's \bin directory. Typically, the path is as
follows (where [#]= the Flare version number):

n Windows 7 or 8 (64-bit versions)

l If you are using Flare 12 or later

C:\Program Files\MadCap Software\MadCap Flare [#]\
Flare.app\Resources\Bin

l If you are using Flare 11 or earlier

C:\Program Files\MadCap Software\MadCap Flare V[#]\
Flare.app\Resources\Bin

n Windows 7 or 8 (32-bit versions)

C:\Program Files (x86)\MadCap Software\MadCap Flare V[#]
\Flare.app\Resources\Bin

NOTE The path that you use depends on your specific system configuration.
For users running the 64-bit version of Windows, you will see two folders
named Program Files on your C: drive. Typically, the folder named
"\Program Files (x86)" stores non-native 32-bit applications, and the "\Program
Files" folder stores native 64-bit applications, such as Flare. If you installed
Flare in a different location, you need to determine the appropriate path to the
\bin directory.
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2. In the bin directory, double-click the file named RegisterItcc.bat.

This runs the batch file. If the registration is successful, a message appears telling you so.

NOTE If the following error message appears, the account you are using may not
have sufficient permissions to run the batch file on the computer.

You will need to use your computer's command line utility to register the DLL as
described below or contact your Windows administrator for assistance with
registering the DLL.
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How to Register the DLL Using the Command Line Utility

1. In Windows Explorer, open the computer's System32 directory. The path is
C:\Windows\System32.

2. Right-click the application file named cmd.exe and select Run as administrator from the
context menu.

3. If the User Account Control message appears, click Yes. This lets you use the command
prompt to make changes on the system.

NOTE In Windows 7, you can use this method to run the command prompt as an
administrator when you are using an account that does not have administrative
credentials. This typically allows most users to make changes to the itcc.dll file in the
Flare \bin directory.
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4. At the command prompt, do the following:

a. Type cd to change directories and press the SPACEBAR. Then type the path to the
Flare \bin directory as shown in this example:

EXAMPLE Use this information to enter the following path, depending on your
version of Flare.

IF YOU ARE USING FLARE 12 OR LATER

C:\Program Files\MadCap Software\MadCap Flare [#]\
Flare.app\Resources\Bin

Below is an example:

C:\Program Files\MadCap Software\MadCap Flare 19\
Flare.app\Resources\Bin
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IF YOU ARE USING FLARE 11 OR EARLIER

C:\Program Files (x86)\MadCap Software\MadCap Flare V[#]\
Flare.app\Resources\Bin

Where [#] appears above, you must enter the correct Flare version number
when typing the system path (e.g., V8, V9, V10.). Below is an example:

C:\Program Files (x86)\MadCap Software\MadCap Flare V9\
Flare.app\Resources\Bin

b. Press ENTER.

5. At the command prompt, type: registeritcc.bat. Then press ENTER. This runs the batch
file. If the registration is successful, a message tells you so.

6. Click OK to acknowledge the message.

7. Close the command prompt.

After registering the DLL, build your Microsoft HTML Help output again. Then retry your search in
the output.
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Search Methods and Syntax
Depending on the output type you are searching, end users can perform a variety of simple text and
phrase searches. Some output types also support the use of boolean operators, the asterisk (*)
wildcard character, and other syntax.

Full-Text Search
All online output types support full-text search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based output,
search is provided by the either the Microsoft Indexing Service or Windows Search.

For all other output types, Flare scans all of the target content and creates a database index for
search. When a user enters a search query, the search engine in the index to retrieve a list of topics
with matches. In Flare, search results include these matches:

n Case-insensitive Matches Search is not case-sensitive. For example, a search for the word
"run" will find matches for "Run" and "run."

n Matches with Variant Endings For example, a search for the word "run" will also find matches
for words such as, "runner," "running," and "runs." Since matches are not case-sensitive, the
results will include topics containing matches such as, "Runner," "Running," and "Runs."
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How to Perform a Full Text Search

1. Open the online output.

2. In the search field, type a partial word or number string.

For example, type ham.

3. Press ENTER or click Search.

NOTE Search highlighting reveals the matches in the topic. In supported output types, you
can change the highlighting color for search hits. See "Search Highlighting" on page 226.
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Phrase Search
All online output types support phrase search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based outputs,
search is provided by the either the Microsoft Indexing Service or Windows Search.

End users can search for phrases by enclosing their search terms in quotation marks. This is useful
when end users want to restrict a search to locate terms that appear in an exact order. For
example, you might want to search for a phrase such as "Dog Friendly."

How to Perform a Phrase Search

1. Open the online output.

2. In the search field, type a word, number, or character string.

3. Press ENTER or click the Search button.

4. Double-click a match in the list to open the corresponding topic.

IMPORTANT If you have enabled the stop words feature, search will not find
matches for queries containing stop words in quotes. For example, if you search for
the phrase "Pets are fun," search will only include topics with the words "pets" and
"fun." This is because the word "are" is part of the stop word list. See "Including Stop
Words in Search" on page 139.

NOTE Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting"
on page 226.
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Boolean Operators
The Microsoft HTML Help, WebHelp, and HTML5 output types support boolean operators —e.g.,
AND, OR, NEAR, NOT, and ( ). Note that when providing users with server-based WebHelp or HTML5
output, boolean operators are not supported. Operators can be used in combination with search
terms to increase or decrease the number of search results.

Requirements and Dependencies

n Eclipse Help Boolean search is supported by the search engine that you configure in the
Eclipse platform. See the Eclipse documentation at help.eclipse.org.

n HTML Help Boolean search is provided by the viewer in accordance with the Microsoft
Compiled HTML (CHM) specification. You must select the supported boolean operator from a
predefined drop-down list. See "Searching a Microsoft HTML Help System" on page 17.

n HTML5 Boolean search is provided by Flare in client-based output only. When delivering
server-based output, the Microsoft Indexing Service or Windows Search handles search. See
the Microsoft documentation for information about the Indexing Service:

http://msdn.microsoft.com/en-us/library/ee805985(v=vs.85).aspx

See the following for information about Windows Search:

http://msdn.microsoft.com/en-us/library/windows/desktop/ff628790(v=vs.85).aspx

See also "Enabling HTML5 Server-Based Output" on page 238.

n WebHelp and WebHelp Plus Boolean search is provided by Flare in client-based output only.
When delivering server-based output (WebHelp Plus), the Microsoft Indexing Service or
Windows Search service handles search. See the Microsoft documentation for information
about the Indexing Service:

http://msdn.microsoft.com/en-us/library/ee805985(v=vs.85).aspx

See the following for information about Windows Search:

http://msdn.microsoft.com/en-us/library/windows/desktop/ff628790(v=vs.85).aspx
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How to Search with Boolean Operators

In the table below, a check mark shows the operators supported by each client-based output type. It
also details any supported variables and provides usage examples:

Operators Usage
HTML
Help HTML51 WebHelp

AND Use to narrow the search and
retrieve only the topics that
contain all of the words it
separates.

Type AND between two or more
terms. This is not case sensitive.

When separating terms with a
blank space, the AND is always
inferred. This is only available in
HTML5 help.

Instead of the word AND, type the
plus symbol (+).

Instead of the word AND, type the
ampersand symbol (&).
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Operators Usage
HTML
Help HTML51 WebHelp

OR Use to search for two or more
words. This broadens the search
results by retrieving topics that
contain any of the words it
separates.

Type or between two or more
terms. This operator is not case
sensitive. 

When separating terms with a
blank space, the OR is always
inferred. This is not available in
HTML5 help.

Type the pipe symbol (|) instead of
typing OR.

NEAR Select from the operator list to find
topics that contain matches that
are in close proximity to each
other.

This is only available in Microsoft
HTML Help. The operator must be
selected from a list.
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Operators Usage
HTML
Help HTML51 WebHelp

NOT Use to search only for matching
topics that do not contain the term
following the operator.

Type NOT before a term. This
operator is not case-sensitive.

Type the exclamation mark (!)
instead of the word NOT.

Use to find topics that contain one
term but not the other.

Type a term, followed by the carat
symbol (^), and then type another
term.

( ) Use parentheses to combine
boolean phrases and search
terms.

Type parentheses ( ) around the
combined terms.

1In HTML5, this is supported only with MadCap Search set as the search engine.

2This only works if you search for one term but not another (e.g., MadCap NOT Flare).

3The carat symbol (^) can be used interchangeably with an exclamation point (!) and
NOT.
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Asterisk (*) Wildcard Search
In the Microsoft HTML Help and WebHelp output types, end users can use the asterisk (*) wildcard
character with the search feature as detailed below.

Requirements and Dependencies

n Eclipse Help Asterisk (*) wildcard search is supported by the search engine that you configure
in the Eclipse platform. For details, see the Eclipse documentation at:

help.eclipse.org

n WebHelp For asterisk (*) wildcard search capabilities to be supported, you must enable the
partial-word search feature. See "Enabling Partial-Word Search" on page 150.

How to Search With the Asterisk (*) Wildcard

In the table below, a check mark shows the different ways you can use the asterisk (*) wildcard in
search. It also provides usage guidelines and examples.

Placement Usage
HTML
Help WebHelp

Before a
Term

Place the asterisk (*) in front of a term to
represent unknown characters.

Inside a Term Place the asterisk (*) inside a term to represent
unknown characters.

After a Term Place the asterisk (*) after a term to represent
unknown characters.

1In Microsoft HTML Help, the asterisk (*) wildcard cannot be used in combination with
other characters and symbols. For example, instead of searching for *.doc, end users
must search for *doc.

CHAPTER 2  34

http://help.eclipse.org/


Partial-Word Search
The HTML5, WebHelp, and WebHelp Plus output types support partial-word searches in their target
outputs. This search method is similar to simple text search, only it allows users to search for
partial-word and number strings. This feature can be enabled in the Performance tab of the
Target Editor. See "Enabling Partial-Word Search" on page 150.

For Eclipse Help, partial-search is provided by the Eclipse platform.

How to Perform a Partial-Word Search

1. In the search field, type part of a word or number string.

For example, type cond.

NOTE The minimum number of characters that you can set for partial searches is 3.
See "Enabling Partial-Word Search" on page 150.

2. Press ENTER or click Search.

The system reveals a list of ranked topics that include matches for the entered search string.

3. Double-click a topic in the list to open it.

NOTE Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting"
on page 226.
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EXAMPLE Search for cond.

As shown below, search retrieves topics containing the string "cond," such as "condition"
and "second."
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Search for 201.

As shown below, the search retrieves topics containing the number string "201," such as
2010, 2011, 2012, 2013, 2014, 2015, 0.201, and 0.0201.
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End User Search Features
The table below summarizes the key search features and capabilities for each output type. With
HTML5 and WebHelp outputs, you can distribute either client- or server-based outputs. This is why
the table below lists them twice—under client- and server-based output.

HTML5 (Client) HTML5 (Server) HTML Help

Glossary Search (Find Matching
Terms)

Index Search (Find Matching Terms)

Predictive Search

See "Setting Up a Search Engine" on
page 49.

Search Favorites (Save Queries to
Favorites List)

Search Query (Asterisk (*) Wildcard
Character)

Search Query (Boolean Operators)

See "Search Methods and Syntax" on
page 27.

Search Query (Full-text Search—not
case sensitive)

See "Search Methods and Syntax" on
page 27.

Search Query (Enclose Terms in
Quotes)

See "Search Methods and Syntax" on
page 27.

Search Results (Narrow Search
Scope Using Search Filter Sets)

See "Search Filter Set Example" on
page 221.
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HTML5 (Client) HTML5 (Server) HTML Help

Search Results (Results Listed in
Ranked Order and Show Rank
Number)

See "Optimizing Search" on page 168.

Search Results (Search Hits
Highlighted in Topics)

See "Search Highlighting" on page
226.

Search Results (Search Hits
Bolded)

1Select the operator from the built-in list.

2Search filters are not supported in Elasticsearch.

3Results are listed in order. Rank number is not visible.
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Content Developer Search Options
This table summarizes the key search features and capabilities that are available to you, the
content developer, for each output type. With HTML5 and WebHelp outputs, you can distribute
either client- or server-based outputs. This is why the table below lists them twice—under client-
and server-based output.

HTML5 (Client)
HTML5
(Server) HTML Help

Enable

"Including Search Bars" on page 43

Content Optimization

"Setting the Search Abstract
Character Limit" on page 137

Content Optimization

"Setting Search Result Importance"
on page 146

Content Optimization

"Including Glossary Terms in
Search Results" on page 153

Content Optimization

"Setting the Number of Search
Results Per Page" on page 135

"Elasticsearch" on page 60

"Google Search" on page 128

Micro Content Search Integration

"Setting Micro Content Containers"
on page 152
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HTML5 (Client)
HTML5
(Server) HTML Help

Search Highlighting

"Customizing the Highlight Color
for Search Hits" on page 229

Search Optimization

"Enabling Partial-Word Search" on
page 150

Search Optimization

"Including Stop Words in Search"
on page 139

Search Optimization

"Excluding Index Entries From
Search" on page 158

Search Optimization

"Excluding Non-Words From
Search" on page 157

Search Optimization

"Setting the N-Gram Size for
Search" on page 164

Search Performance

"Chunking Large Search Database
Files" on page 160

Search Performance

"Pre-Merging Search Database
Files" on page 159

Search Results

"Customizing Search Filter
Ordering" on page 218
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HTML5 (Client)
HTML5
(Server) HTML Help

Search Toolbar

Web Toolbars in WebHelp Outputs

Styles

Styles for Generated Pages

1HTML5 skin.

2Standard skin.

3This is supported if you are using Elasticsearch or MadCap Search, but not
Google Search.
4This is supported only in HTML5 Side Navigation, Top Navigation, and skinless
outputs. It is not supported in HTML5 Tripane output.
5Stop words are always enabled.

6Index entries are always excluded.

7Non-words are always excluded.

8SQL Server Compact is required.
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CHAPTER 3

Including Search Bars
The first step in making search accessible in your online documentation is to include a search bar.

HTML5 output is designed to show a search bar at the top of all topics via the skin. You just need to
make sure this option is enabled, which is the default setting. Therefore, you might not need to do
anything.

However, you might want to insert a search bar elsewhere (e.g., in the middle of your Home page).
In this case, you would need to use a Search Bar proxy. You might also need to hide the search bar
from some topics so that you do not have two search bars on a page.

This chapter discusses the following:

How to Enable the Search Bar in an HTML5 Skin 44

How to Insert a Custom Search Bar 45

How to Hide the Search Bar From All Topics 46

How to Hide the Search Bar From a Single Topic 47

How to Enable Search in a Skin for Other Output Types 48
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How to Enable the Search Bar in an
HTML5 Skin
1. From the Project Organizer, open the HTML5 skin.

2. Select the Styles tab.

3. In the Header section, expand Search Bar.

4. Expand Layout.

5. In the Display field, make sure block is selected.

6. Click to save your work.
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How to Insert a Custom Search Bar
1. Open a template page or topic, depending on whether you want the search bar to be show on

many pages or only one page.

2. Place your cursor where you want the search bar to be shown in the output.

3. Select Insert > Proxy > Insert Search Bar Proxy. The Search Bar Proxy dialog opens.

4. If you have added a Search Bar skin component to your project and want to use it to control
the look of the search bar, you can select it from the Skin File field.

If you do not select a Search Bar skin component in this field, Flare uses the first one it finds
in your project (if one exists). Otherwise, Flare provides a default design.

NOTE The Search Bar proxy and skin component are not supported in HTML5
Tripane output.

5. Click OK. The proxy is added.

6. Click to save your work.
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How to Hide the Search Bar From All
Topics
1. From the Project Organizer, open the HTML5 skin.

2. Select the Styles tab.

3. In the Header section, expand Search Bar.

4. Expand Layout.

5. In the Display field, select none.

6. Click to save your work.
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How to Hide the Search Bar From a
Single Topic
1. Assuming you are already using a primary stylesheet for all topics, make sure the option to

Allow local stylesheets is selected.

2. Create a new stylesheet to be used for the topic where you want to hide the search bar.

3. Open the new stylesheet in the Internal Text Editor (i.e., in the Content Explorer, right-click it
and select Open with > Internal Text Editor). Then, copy and paste the following into it.

.nav-search
{
    display: none;
}

4. Click to save your work.

5. Associate the topic with the new stylesheet.
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How to Enable Search in a Skin for
Other Output Types

HTML Help, WebHelp, and WebHelp Plus are not as commonly used as HTML5. However, if you are
using one of these outputs, you can enable search as follows.

1. From the Project Organizer, open the Standard skin.

2. Select the General tab.

3. In the Features list, click the Search check box.

4. (Optional) If you are creating Microsoft HTML Help, you can include advanced search
options. To enable or disable these options, open the skin. In the Skin Editor, click the HTML
Help Setup tab, then place a check in the Show Advanced

5. Search box.

6. Click to save your work.
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CHAPTER 4

Setting Up a Search Engine
Supported In:

For HTML5 targets, you can choose the type of search engine you want people to use—MadCap
Search, Google Search, or Elasticsearch (for Side Navigation, Top Navigation, or skinless output).
There are additional steps that you can follow and features you can select, depending on the search
engine you choose. For MadCap Search and Elasticsearch, you can include micro content in the
output, which can especially enhance your search results.

This chapter discusses the following:

Comparison of Search Engine Options 50

MadCap Search 55

Elasticsearch 60

Google Search 128

CHAPTER 4  49



Comparison of Search Engine Options
There are benefits to any of the search methods offered by Flare. Some users might prefer the
search results returned by Google. However, others might prefer the results returned by MadCap.
Or some users might want all of the configurable options provided by Elasticsearch.

TIP To determine the type of search that is best for you, we recommend that you generate
different outputs using each method. Then perform several different searches and see
which results you like best.

MadCap Search Elasticsearch Google Search

Less Time and
Effort to Set Up

Setting up MadCap
Search in a Flare
project takes only a
few seconds.

Setting up
Elasticsearch is done
within the Target
Editor and Destination
Editor in Flare. Web
servers also need to
be configured to
support Flare, along
with the Elasticsearch
service.

Setting up a Google
custom search engine
(CSE) and performing
other necessary tasks
requires a
combination of steps
in both Google and
Flare. This can take a
bit of time to
complete. However, it
is usually just a one-
time setup.

Public vs. Local
Output Flexibility

Output can be
searched whether it is
available publicly or
locally.

Output must be
published on a server
in order to use the full
capability of
Elasticsearch.

Output must be
available publicly so
that you can use
Google. Output
cannot be behind a
firewall.
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MadCap Search Elasticsearch Google Search

Multiple Outputs Searches will include
results for only the
Flare output that is
open.

You can manage
multiple HTML5
targets that use
Elasticsearch through
the Content Services
Portal.

You can add
multiple folders/sites
to be included in your
Google custom
search engine (CSE).
Each of these sites
can be a separately
published Flare
output. When users
search from one of
the published Flare
outputs, results will
display for all of the
outputs.

Other File Types In order to include file
types such as PDF in
your search results,
you need to generate
and publish server-
based output.

Most file types are
included in the search
results.

If you have added
other types of files
(e.g., PDF) to the site
(s) associated with
your CSE, they may be
included in search
results.

Search Tailored to
Flare Projects

MadCap Search
rankings are
specifically tailored
for Flare users. They
take into account not
only H1-H6 headings,
but also index
keywords, glossary
terms, etc. See
"Ranking Search
Results" on page 201.

Elasticsearch does
not provide any direct
mapping of search
criteria to the
structure of a Flare
project.

Google does not
recognize the unique
characteristics of a
Flare project (e.g.,
index keywords,
glossaries).
Therefore, those
elements will have no
effect on how Google
ranks pages in the
results.
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MadCap Search Elasticsearch Google Search

Micro Content in
Results

MadCap Search
lets you include micro
content in your search
results, which can
especially improve the
experience for users.

Elasticsearch lets
you include micro
content in your search
results, which can
especially improve the
experience for users.

Google does not
include micro content
(created in Flare) in
your search results.

Glossary
Definitions in
Results

MadCap Search
will fetch your
project’s glossary
terms and feature
them at the top of
search results.

Elasticsearch does
not provide an option
to include glossary
terms in your search
results.

Google will not fetch
your project’s
glossary terms and
feature them at the
top of search results.

Results for
Incorrectly Typed
Searches

Incorrectly typed
search terms will not
return results.

The partial-word
search and fuzzy
match settings allow
for numerous
searches to be
returned when these
settings are enabled.

If an end user
incorrectly enters a
search term (e.g.,
types “Tble” instead of
“Table”), Google will
often guess the
correct term and
show results anyway.
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MadCap Search Elasticsearch Google Search

Better Search and
Indexing Speed

Search results
might be faster
because the output is
immediately indexed
once it is generated.
You do not need to
spend any extra time
indexing your pages
or waiting for search
results to appear.

The administrator
portal allows for the
search indexes to be
managed closely.
This will assist in
keeping search result
times optimal.

Search results might
lag at times,
depending on the size
of the output and
whether Google is
finished with the
indexing (i.e., making
your output available
for searches).

Google will index your
pages automatically
over time, but it can
take awhile,
sometimes weeks.

Mobile Devices Search results are
“chunked” and then
collapsed so that they
can be displayed
when a search is
performed. This is
usually okay on PCs,
but if you try to
perform a search on a
mobile device, the
results might be slow
or even crash
because the device
cannot handle the
number of search
results.

Search results
always come from a
server, so you do not
need to be concerned
about the ability of the
mobile device to
handle the
information.

Search results
always come from a
server, so you do not
need to be concerned
about the ability of the
mobile device to
handle the
information.

No
Advertisements

No advertisements
are included in search
results.

No advertisements
are included in search
results.

Users might see
advertisements in
search results.
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MadCap Search Elasticsearch Google Search

Customize Auto-
Complete Results

There are no options
available for auto-
complete results.

You can enable
multiple options to
include a mix of
personal and global
searches on your
output. There is also
an option to include
project content
information such as
topic titles and the file
path in your project.

While Google Search
does provide auto-
complete results, it
does not provide the
ability to customize
these results.

Customize
Predictive Search

MadCap Search does
not offer any
predictive methods in
obtaining search
results.

There are multiple
options that allow you
to obtain predictive
results when
searching, especially
when using auto-
complete options.

Google Search
provides a measure of
predictive results,
although it is not
customizable within
Flare.

NOTE Google Search is not supported for HTML5 Tripane output.

NOTE For MadCap Search, the look of the search bar and results can be customized
through these skins and components: Top Navigation skin, Side Navigation skin, Search
Bar skin component, and Search Results skin component. However, with Google Search,
any changes in these skins are not supported. Instead, the look is controlled via Google.

NOTE Keep in mind that the exact steps in Google may change over time as the user
interface is adjusted.
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MadCap Search
Supported In:

MadCap Search is Flare's built-in search engine. When an HTML5 target is created, it is set by
default to use this search engine. MadCap Search considers heading styles, index keywords,
glossary terms, and more when ranking regular search results, and it considers phrases and
alternate phrases when ranking micro content. You can customize the search engine by setting
options such as search result importance, glossary terms in the results, number of search results
per page, and abstract character limit.

How to Set Up a MadCap Search Engine
1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine field, select MadCap Search.

4. You can complete various options to optimize the search, then click to save your work.

Search Results

Results per page You can change the number of search results that appear on each page.
This makes it easier to navigate between pages of search results and
improves loading times, especially for users who access output from a
mobile device. Setting a reasonable number of results per page also
makes it easier for search indexing services (i.e., spiders, crawlers, or
bots) to locate pages in output, improving search results. See "Setting the
Number of Search Results Per Page" on page 135.
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Abstract character
limit

In HTML5 output, you can set a character limit for automatically
generated abstracts that appear in your search results. This allows your
users to see a brief summary of each topic in the search results, while
keeping the search results page easy to scan. You can set the character
limit as long or as short as you like. When creating an automatic abstract,
Flare scans all text elements in the topic, including headings and
paragraphs, and includes them in the abstract until the character limit is
met. See "Setting the Search Abstract Character Limit" on page 137.

Partial word
searching

This allows part of a word to be searched in the target database. For
example, the string "sear" could return results for "search." The Minimum
word size field can be set from 3-10.

NOTE Enabling this setting could increase the build time and the
size of the search index for your target.

Advanced Search Options

Include Importance
(recommended)

In HTML5 output, the Flare search engine uses a combination of factors
to rank search results. The search engine considers the number of links
to a topic (Importance) and the number of times a search term appears
in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each
topic. This is not recommended unless you have one topic that is linked
too many times that it would skew your search results. See "Setting
Search Result Importance" on page 146.

Include glossary
results

For HTML5 output, search results display glossary terms if they are used
as the search text. This option to display glossary terms in search results
is enabled by default. However, it can be turned off in the HTML5 Target
Editor. See "Including Glossary Terms in Search Results" on page 153.

Exclude non-words
from search

If you have a project that contains a lot of content that is not composed
of regular letters and numbers (e.g., angled brackets), you can set your
target to avoid these "non-words" when users perform a search in your
Help system. This will improve the search performance that your users
experience. See "Excluding Non-Words From Search" on page 157.
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Exclude index
entries from
search

If you insert index markers in your project, those markers by default are
included in searches that users perform in your output. If you want to
exclude index entries from searches, you can do so. See "Excluding Index
Entries From Search" on page 158.

Pre-merge search
database file

If you have multiple projects whose outputs are set to be merged when
you build the parent project, you can pre-merge search database files. If
you select to pre-merge the search database file, you disable runtime
merging, which means that you cannot compile and publish a "sub-
project" later. You must generate and publish all linked Help systems at
the same time. Selecting this option may slow down the generation of
the output, but it will significantly increase the speed with which the
output loads for the end user.

Chunk large search
database file

You can control the size of "chunks" used when generating the search
database files for a target. After you choose this option, select the
number of bytes for each chunk. The chunk size affects the speed that a
Help system loads for a user. Depending on the internet connection,
different results will be seen. The smaller the chunk size, the greater the
number of chunks that will be sent. A large number of chunks may result
in a slower speed, especially if you have many merged "sub-projects" and
the index is being merged. Chunking may slow down the generation of
your output somewhat, but it increases the speed that the output loads
for end users. For best results, you should test the different chunk sizes.
Click the drop-down next to the Maximum chunk size field to set the
maximum size of your search database file.

N-gram size You can adjust the n-grams, which are character chunks used to
separate words in Chinese, Japanese, and Korean projects. Chinese,
Japanese, and Korean languages do not have spaces as word
boundaries, so n-grams are used to separate the words. Smaller n-gram
values produce smaller search database file sizes. They also lead to
more search results, which may be less accurate. On the other hand,
larger n-gram values produce larger search database file sizes. They also
lead to fewer search results, which may be more accurate. The default
size in this field is optimal for most situations.
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Featured Snippets

Filter Select to control which pieces of micro content to include for the
featured snippets area.

n Do not include in search results No micro content is included in the
featured snippets area.

n All micro content files Every phrase from all of your micro content
files may be included.

n Specific micro content files In the drop-down(s), choose one or
more micro content files. Every phrase from those files may be
included.

n Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values. Micro
content phrases that match may be included.

Limit number of
results

Control the maximum number of micro content responses that are
allowed to display in the featured snippets area. If you leave it set at 1,
Flare displays only the best match from your micro content file(s); if you
enter 3, Flare displays up to the best three matches (if that many exist).
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Knowledge Panel

Filter Select to control which pieces of micro content to include the Knowledge
Panel.

n Do not include in search results No micro content is included in the
Knowledge Panel area.

n All micro content files Every phrase from all of your micro content
files may be included.

n Specific micro content files In the drop-down(s), choose one or
more micro content files. Every phrase from those files may be
included.

n Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values. Micro
content phrases that match may be included.

Limit number of
results

Control the maximum number of micro content responses that are
allowed to display in the Knowledge Panel. If you leave it set at 1, Flare
displays only the best match from your micro content file(s); if you enter
3, Flare displays up to the best three matches (if that many exist).

Sitemap

Generate sitemap For web-based targets, you can generate a sitemap when compiling your
output. This helps with search engine optimization (SEO), making it
easier for search indexing services (i.e., spiders, crawlers, or bots) to find
your output. Therefore, the entire output is indexed and search engine
results are improved. 

Web URL This is the URL used for your published output.
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Elasticsearch
Supported In:

Elasticsearch is a powerful search engine that provides numerous unique, configurable options,
including "fuzzy matching” (i.e., matching similar words), predictive search, and auto-completion.

Elasticsearch is enabled by two web services, one used by Flare and the other used by
Elasticsearch. The Elasticsearch web service runs a portal that lets you manage the targets, topics,
and indexes employed by the Elasticsearch engine in your server-based HTML5 target.
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Process

1. "Installing Elasticsearch on a Remote Server" on page 67

2. "Enabling Elasticsearch in the Target Editor" on page 99

3. "Creating Destination Files for Elasticsearch" on page 107

4. "Associating Elasticsearch Destinations With a Target" on page 109

5. Generating and Testing Output—"MadCap Process Manager" on page 110

6. Managing Size of Search Indexes—"Content Services Portal" on page 111

7. (Optional/Periodic) "Upgrading Elasticsearch and Content Services on a Remote Server" on
page 119
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EXAMPLE Bob wants to use Elasticsearch with his HTML5 output.

First, he sends his network administrator the steps for setting up an Elasticsearch remote
server.

After the network administrator finishes setting up the server, she sends Bob the URL for it.
In this case, let’s say the URL is:

https://ourelasticsearchservices.fictionsoft.com

Bob opens his HTML5 target, selects the Search tab, and chooses Elasticsearch as the
search engine type.

He also decides which Elasticsearch options on that tab he wants to use and sets them
accordingly.
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Next, Bob creates a primary publishing destination. This is the destination where he will
send his output.

Let’s say Bob needs to upload his output to this location:

help.fictionsoft.com/myoutput/
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One option is that Bob could use file transfer protocol (FTP) to copy his output directly up
to the server where his output will be hosted. But suppose Bob prefers to use a third-party
tool (say, FileZilla) to transfer his output files to the server. In that case, Bob chooses File
System as the type, and for the directory he selects a folder that he created in his
Documents folder.

Now Bob creates an Elasticsearch destination file. In this file, he chooses Elasticsearch as
the type, and he enters the URL that his network administrator gave him
(https://ourelasticsearchservices.fictionsoft.com).
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Next, Bob returns to his target and opens the Publishing tab. In this tab, he places a check
mark next to his primary destination. Then in the Elasticsearch Destination cell, he chooses
the other destination file.

After saving all his changes, Bob builds the target. When that is done, he clicks the Publish
button in the Target Editor, which copies the output files to the local folder he set up in his
Documents directory.

Finally, Bob uses his third-party tool to transfer the output files from that Documents folder
up to their final destination (help.fictionsoft.com/myoutput/). When users access that
output, the search function will be using Elasticsearch features. (If Bob decided to use FTP
or SFTP, the output would transfer directly to the server, and using the third-party tool
would not be necessary.)

NOTE Synonyms are not supported in Elasticsearch.

NOTE Elasticsearch is not supported for outputs built on MadCap Central. However, you
can publish directly from Flare to Central via a destination and Elasticsearch will be
supported.

NOTE Search filters are not supported in Elasticsearch.
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NOTE Multilingual Elasticsearch publishing requires all targets to use the same GUID. This
is set on the Search tab of the Target Editor. If the GUIDs in the targets are different, you
might have empty targets on the portal or experience a publishing failing with error 400. If
necessary, open targets in the Internal Text Editor to modify the GUID.

NOTE If you enable the Mark of the Web setting in your Elasticsearch target and viewing
the output locally in Internet Explorer, you will continuously receive the following warning
message:

This message will display every time you enter search criteria. In order to avoid receiving
this message, it is recommended that you disable the Mark of the Web setting. See the
Flare Targets Guide or the Flare online Help for more information.

NOTE If you are viewing your generated Elasticsearch output on Microsoft Edge, you will
not be able to search. In order to use Edge for your Elasticsearch output, you will need
disable loopback in your Edge browser. A search on the internet can provide steps for doing
this.
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Installing Elasticsearch on a Remote Server

Information for Network Administrators

Before you can publish HTML5 output to use Elasticsearch, you must have a remote server
configured to run the Elasticsearch service as well as the Content Services web application. The
Elasticsearch service is required to perform searches from the indexed search data. The Content
Services Portal is provided as a central location to manage the search data published from Flare.

NOTE Please be aware that setting up a remote server for Elasticsearch can be a lengthy
process. The procedure typically requires administrator permissions. If you are unfamiliar
with how to install a web server, it is highly recommended to contact your Network
Administrator for assistance.

Prerequisites for Elasticsearch
The following prerequisites for Elasticsearch are only necessary if you do not already have the
programs on your computer. Go through each section to confirm you have all the programs and
correct options set, and then follow the given procedures if anything is missing.

NOTE When setting up a computer as a remote server, you can use a Windows Server
operating system (e.g., Windows Server 2016), or a regular Windows operating system
(e.g., Windows 10). Which system you use depends on your needs. A Windows Server is
often used in business settings.
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Operating System With Internet Connection Make sure your operating system is updated
with the latest service packs, critical patches,
and security updates from Microsoft.

.NET Framework 4.6 or newer This is the software development framework
for building and running applications on
Windows. The minimum required .NET
Framework version required is 4.6. It also
works with newer versions of .NET
Framework.

ASP .NET ASP.NET is part of .NET Framework (it does
not require a separate install from .NET).
ASP.NET is the web application framework for
building dynamic web pages. This feature
gets “turned on” in Windows.

IIS Web Server Microsoft Internet Information Services (IIS) is
a web service role that is enabled in the
operating system to give the system its web
server capabilities. IIS must be installed on the
computer that will act as your Elasticsearch
web server. The minimum version required is
IIS 6. Newer versions work as well.

.NET 6.0.13 Windows Hosting Bundle Microsoft .NET Core is used to create server
applications that run on Windows, Linux, and
Mac.

Java SE Development Kit You can install a paid Oracle (JDK) Java SE
Development Kit, or a free Open JDK Java 1.8
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NOTE For details about supported operating systems and hardware requirements for
Microsoft programs, refer to Microsoft documentation for downloads. See the following:

https://www.microsoft.com/en-us/download/windows.aspx

NOTE The following procedures use Windows 10. Be advised that some user interfaces
might vary slightly depending on the operating system you are using.
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How to Determine if Programs are on the Computer

1. Open the Control Panel.

2. Select Programs and Features.

3. Compare the listed applications with the required programs (e.g., Microsoft .NET Core 6.0.13
Windows Server Hosting). If programs for a remote server are missing, you may have to add
them.
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How to Install .NET Framework

It is necessary to install .NET Framework to run certain applications on Windows that were created
with it. However, many versions of Windows already include .NET Framework.

NOTE It is important to install .NET Framework before installing the IIS web server.

1. In a browser, navigate to:

https://dotnet.microsoft.com/download/dotnet-framework

2. Locate the .NET Framework version, and click the link to download the runtime installer. You
can choose to install version 4.6 or newer.

3. In Microsoft’s configuration dialog, follow the installation wizard.

NOTE If you are installing on a Windows Server operating system, you can use the Server
Manager to enable .NET Framework features. See "How to Set Roles and Features With the
Server Manager on Windows Server" on page 73.
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Installing Internet Information Services

The Microsoft Internet Information Services (IIS) gives the system its web server capabilities. If the
server that will act as your Elasticsearch web server does not yet have IIS, find the download on the
Microsoft website and install it.

NOTE Since newer versions of Windows come with IIS, check to see if IIS is already on
your computer. It might be installed, but you just have to enable it via the Control Panel
(Turn Windows features on or off). If you want a newer version, then you might have to
download and install it.

NOTE If working with a Windows Server operating system, the Server Manager program is
available to you to manage and configure web server roles and features (see "How to Set
Roles and Features With the Server Manager on Windows Server" on the next page). If you
are working with a regular Windows operating system, use the Windows Feature dialog to
manage and configure web server roles and features for .NET and IIS (see "How to Set
Roles and Features With Windows Desktop" on page 75).
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How to Set Roles and Features With the Server Manager on Windows
Server

To enable roles and features on a Windows Server, you can do so via the Server Manager.

1. From the Windows Server operating system, open the Server Manager.

2. From the Manage menu, select Add roles and features. Click Next.

3. In the Add Roles and Features wizard, select Role based or feature based installation. Click
Next.

4. Choose Select a server from the server pool. Click Next.

5. Scroll down in the Server Roles list and select Web Server (IIS). Click Next.

6. In the Features list, expand and select .NET Framework 4.x Advanced Services, and then
select ASP .NET 4.x.

7. In the Role Services list, select the following under Web Server (IIS):

n Web Server

l Common HTTP Features

o Static Content

o Default Document

o Directory Browsing

o HTTP Errors

l Security

o Request Filtering

o Basic Authentication

o Windows Authentication

l Application Development

o .NET Extensibility 4.x

o ISAPI Extensions

o ISAPI Filters

o ASP .NET 4.x
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l Health and Diagnostics

o HTTP Logging

l Performance

o Static Content Compression

n Tools Management

l IIS Management Console

l IIS 6 Management Capability

o IIS Metabase and IIS 6 Configuration Compatibility

8. Click Next through to the screen with the Install button enabled, then click Install.
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How to Set Roles and Features With Windows Desktop

To enable roles and features on a regular Windows desktop to set it up as a remote server, you can
do so via the Windows Feature, Control Panel app.

1. In the Windows Search bar, type turn on windows.

2. Click the resulting item, Turn Windows features on or off. The Windows Features dialog
opens.

3. Expand .NET Framework 4.x Advanced Services (the version number may vary depending on
the original installation and updates).

4. Select the ASP.NET 4.x check box.

5. Expand Internet Information Services.

6. Expand Web Management Tools, and select IIS Management Console.
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7. Expand the IIS 6 Management Compatibility folder, and select IIS Metabase and IIS 6
configuration compatibility (the version number may vary depending on original installation
and updates).

8. Expand World Wide Web Services, and expand the Application Development Features folder.
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9. Select items .NET Extensibility 4.x, ASP.NET 4.x, ISAPI Extensions, and ISAPI Filters.

10. Expand the Common HTTP Features folder.
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11. Select items Default Document, Directory Browsing, HTTP Errors, and Static Content.

12. Expand the Health and Diagnostics folder, and select HTTP Logging.
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13. Expand the Performance Features folder, and select Static Content Compression.

14. Expand the Security folder.

15. Select items Basic Authentication, Request Filtering, and Windows Authentication.

16. Click OK. The installation begins.

17. At the Windows completion message, click Close.
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Optional—How to Verify IIS Installation

Verifying the installation of IIS is not necessary to do, but it might provide peace of mind that it got
installed correctly.

1. From the Windows Search bar, type IIS.

2. Click the resulting item, Internet Information Services (IIS) Manager app. The IIS Manager
opens, and should look similar to the image below. When you install IIS for the first time, a
"Default Web Site" is automatically created.
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3. Open a web browser, and in the URL field type localhost. The default IIS web page
displays.

What’s Next?

"Configuring the Web Server" on the next page.
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Configuring the Web Server
At this point, .NET Framework and IIS are installed for the Elasticsearch engine. A couple more
programs are needed for the server, and a new system environment variable. Go through each
section to confirm you have all the programs and correct options set, and then follow the given
procedures if anything is missing.

How to Install .NET Core

The Microsoft .NET Core 6.0.13 Windows Hosting Bundle is needed for apps to run behind the IIS.
This Windows Hosting Bundle should be installed after IIS is installed.

1. Install the Microsoft .NET Core 6.0.13 Windows Hosting Bundle from the following link.

https://dotnet.microsoft.com/download/dotnet-core

2. In Microsoft’s configuration dialog, follow the installation wizard.

3. Reboot (server or computer).

CHAPTER 4  82



How to Download Java JDK

NOTE Oracle charges license fees to use their Java Development Kit (JDK). Therefore, we
also provide support for a free alternative to Oracle's JDK. This alternative—Open JDK—can
be used to support Elasticsearch on both local and remote servers made through the
Content Services Portal.

1. In a browser, navigate to:

https://www.madcapsoftware.com/downloads/java.aspx

2. Choose one of the following Java JDK links to download.

n Click Oracle (JDK) Java SE Development Kit (this option may have costs
associated with it).

i. From the Java SE Development Kit 8 Download web page, scroll down to
the Java SE Development Kit 8u261 section. S

The latest version available is subject to change.

ii. Determine the appropriate Windows option for your machine (e.g.,
Windows x64, or Windows x86).

iii. Select the corresponding download file (e.g., for Windows x64, the link is
jdk-8u261-windows-x64.exe).

iv. Click the executable file to install.
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n Click Open JDK Java 1.8 (this option is free).

i. From the ojdkbuild web page, scroll down to the Downloads for Windows
x86_64 section. See the following:

https://github.com/ojdkbuild/ojdkbuild

ii. From the bulleted list items, locate the latest version for the MSI installer
(e.g., java-1.8.0-openjdk-1.8.0.265-1.b01.ojdkbuild.windows.x86_64.msi).
The latest version available is subject to change (build numbers in path for
given example might not match).

iii. Click the MSI executable file to install.
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How to Edit Environment Variables

After Java JDK has been installed, a new environment variable is needed.

1. From the Windows Search bar, type Environment Variables.

2. Click the resulting item from the Control Panel, Edit the system environment variables. The
System Properties dialog opens.

3. Click the Environment Variables button.

4. In the Environment Variables dialog, in the System variables section, click New.

5. In the New System Variable dialog, in the Variable name field, type JAVA_HOME.

6. Use the Browse Directory or Browse File to navigate to the folder where Java JDK was
installed. Once selected, the Variable value field populates with that path (e.g., C:\Program
Files\ojdkbuild\java-1.8.0-openjdk-1.8.0.252-2). Then click OK.

7. In the Environment Variables dialog, click OK.

8. In the System Properties dialog, click OK.

9. Reboot after adding the environment variable.
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Optional—How to Verify the Java JDK Installation

1. From the Windows Search bar, type cmd, and press ENTER to open a command prompt.

2. At the command prompt, type javac and press ENTER. If you see javac options display
below the command prompt, then Java JDK is working properly.

3. Close the command prompt.

What’s Next?

"Gathering Required Files for the Remote Server" on the next page.
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Gathering Required Files for the Remote Server
With the IIS Web Server configured, it is necessary to gather the required files from Flare and copy
them to the remote server.

How to Copy Files to the Remote Server

1. From the computer where Flare is installed, use Windows File Explorer to navigate to the
Elasticsearch folder (e.g., C:\Program Files\MadCap Software\MadCap Flare
19\Flare.app\Resources\Elasticsearch).

2. Copy the Elasticsearch folder to the remote server computer (e.g., C:\Elasticsearch). (If you
copy files to this location, you may receive a message requiring administrative permission for
this action. Click Continue.)

NOTE The Elasticsearch folder can be copied anywhere on the computer. It is also
better to keep the Elasticsearch folder outside of the web server for security
purposes.

3. Navigate to the Web.ContentServices folder from the location where you have Flare installed
(e.g., C:\Program Files\MadCap Software\MadCap Flare
19\Flare.app\Resources\WebHelp2\ContentServices\Web.ContentServices).

4. Copy the Web.ContentServices folder to the web server folder of the remote server (e.g.,
C:\inetpub\wwwroot). (If you copy files to this location, you may receive a message requiring
administrative permission. Click Continue.)

What’s Next?

"Setting Up the Elasticsearch Server and Content Portal" on the next page.
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Setting Up the Elasticsearch Server and Content Portal
Work through each section below to complete the remaining items needed for the Elasticsearch
service.

How to Install the Elasticsearch Service

Install Elasticsearch on the remote server to provide the engine for the Elasticsearch service.

1. From Windows File Explorer, right-click the Elasticsearch folder on the remote server, and
select Properties.

2. In the Elasticsearch Properties dialog, select the Security tab.

3. In the Groups or user names section, select the Everyone account. If this account is not listed,
do the following.

a. Create this account by clicking Edit. (You need to be signed is as an administrator.)

b. In the Permissions for Elasticsearch dialog, click Add. The Select Users, Computers,
Service Accounts, or Groups dialog opens.

c. In the Enter the object names to select section, type Everyone. Click OK.

4. In the Permissions for Elasticsearch dialog, choose the permissions for Everyone. Under the
Allow category, select Read and Write.

5. Click OK.

6. Navigate to Elasticsearch\config directory, and open the elasticsearch.yml file in a text editor
(e.g., right-click, and select Edit with Notepad++).

7. Under the Network section, find the string “http.port: 9200” and remove the # character from
it.

NOTE Elasticsearch uses port 9200 by default. You will notice in the
Elasticsearch.yml file that the http port is 9200, and in the appsettings.json file the
port is 9602 (in a later step). These numbers must match. You can choose to edit one
of the files with either number. Just make sure they show the same number after the
edits. If you change the port number in the YML file, you can specify the port number
where it reads: http.port: 9200.
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8. Save the YML file.

9. In the Windows Search bar, type cmd.

10. In the command prompt, navigate to the location of the copied Elasticsearch\bin directory
(e.g., cd C:\Elasticsearch\bin).

11. Type elasticsearch-service.bat install and press ENTER.

12. Type elasticsearch-service.bat start and press ENTER. Elasticsearch is now
running as the remote web server.
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How to Set Up the Content Services Portal

The Content Services Portal is necessary in order to manage the search data for the Elasticsearch-
enabled HTML5 output.

1. From Windows File Explorer, right-click the Web.ContentServices folder on the remote server,
and select Properties.

2. In the Web.ContentServices Properties dialog, select the Security tab.

3. In the Groups or user names section, select the Everyone account. If this account is not listed,
do the following.

a. Create this account by clicking Edit. (You need to be signed is as an administrator.)

b. In the Permissions for Web.ContentServices dialog, click Add. The Select Users,
Computers, Service Accounts, or Groups dialog opens.

c. In the Enter the object names to select section, type Everyone. Click OK.

4. In the Permissions for Web.ContentServices dialog, choose the permissions for Everyone.
Under the Allow category, select Read and Write.

5. Click OK.

6. In the Web.ContentServices folder on the remote server, create a folder titled "logs.”
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7. In the Web.ContentServices folder on the remote server, open the appsettings.json file in a
text editor (e.g., right-click, and select Edit with Notepad++).

a. Under the ConnectionStrings section, update the path to be used for the
DefaultConnection. The default string line should read as shown in the following image.

NOTE The Indices.db file is actually not created until the Content Services
application is started in IIS and users start searching on the Elasticsearch
output. In this step, you are simply specifying the location of where you want
this file to reside on your remote server.

NOTE Elasticsearch uses port 9200 by default. You will notice in the
Elasticsearch.yml file that the http port is 9200 (in a previous step), and in the
appsettings.json file the port is 9602. These numbers must match. You can
choose to edit one of the files with either number. Just make sure they show
the same number. If you change the port number in the JSON file, you can
specify the port number where it reads: http://localhost: 9602.
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b. Under ContentServicesStartupConfigSettings, update the path to be used for the
DataRootDir. The default string line should read as shown in the following image.

c. Save the JSON file.

NOTE Ensure that the paths you provide for DefaultConnection and
DataRootDir in the appsettings.json file have read/write permissions for the
user account logging into the web server.

WARNING If you decide to place the Web.ContentServices folder in a different
location from the C:\inetpub\wwwroot location, make sure the configuration
settings in the appsettings.json file match the location on your remote server
where you placed the Web.ContentServices folder.
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Optional—How to Restrict Access to Content Services

To restrict access to the Content Services Portal, configure the Content Services web application.
This is done by installing the URL Rewrite Module, which will enable IP address security restrictions
to work in your web.config.file. This is an optional procedure.

1. In a browser, navigate to:

https://www.iis.net/downloads/microsoft/url-rewrite

2. From the URL Rewrite web page, scroll down to the Download URL Rewrite Module 2.1
section.

a. Determine the appropriate download option for your machine (e.g., x64 installer), and
select it.

b. Click the executable file to install.

3. In the Web.ContentServices folder on the remote server, open the web.config file in a text
editor (e.g., right-click, and select Edit with Notepad++).

4. Remove the comment characters from the <rewrite> and </rewrite> tags in this file.

5. Modify YOUR_IP_ADDRESS with your desired IP address pattern. You can enter a range of IP
addresses in this field, or a singular IP address. This will block other addresses that do not
match your IP address pattern from gaining administrator access to your Content Services
Portal.
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NOTE You can enter a single IP address of the remote server to limit portal access to
users only on that computer. However, you might need to provide access for more
than just the remote server computer. For example, enter a range of IP addresses to
provide access for authors to publish to the server.
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How to Configure the Content Services Web Application

1. From the Windows Search bar, type IIS.

2. Click the resulting item, Internet Information Services (IIS) Manager app to open IIS Manager.

3. Right-click Application Pools, and select Add Application Pool. The Application Pool dialog
opens.

4. In the Name field, type a name (e.g., MyAppPool). Keep the other default settings, and click
OK. For information about application pools, refer to Microsoft documentation:

https://docs.microsoft.com/en-
us/iis/configuration/system.applicationhost/applicationpools/

5. In the IIS Manager, navigate to Sites > Default Web Site.

6. Right-click Default Web Site, and select Add Application.

7. Enter the name of the Alias for your Elasticsearch website (e.g., MyPortal).

8. Click the Select button, and choose your Application pool.

NOTE You can use the default Application pool or create a new one for this service.

9. Next to the Physical path field, click the ellipsis button.
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10. Select the C:\inetpub\wwwroot\Web.ContentServices directory. Or, if you placed the
Web.ContentServices directory in another location on your server, select that location
instead.

11. Click OK. Your Content Services application is now displayed under Default Web Site in IIS.
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12. Click Start (or Restart if it is already running) on your Default Web Site. The Content Services
application is now running.
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Optional—How to Verify Content Service Portal Installation

Verifying the installation of Content Services Portal is not necessary to do, but it might provide
peace of mind that is running properly.

1. From the Windows Search bar, type IIS.

2. Click the resulting item, Internet Information Services (IIS) Manager app. The IIS Manager
opens and should show the website configured from earlier steps.

3. Right-click the portal (e.g. MyPortal) and select Manage Website > Browse. If the following
page displays, the portal was configured successfully.

The URL for the portal displays as http://localhost/MyPortal where “MyPortal” is the name of
the website picked in an earlier step. In order for another computer to have access to this
server, replace “localhost” with the name of the remote server. For example, the URL to use
from another computer to access this portal is http://[name of server]/[MyPortal].

4. Ensure the computer with Flare (used to publish to the server) has access to the remote
server. Open a browser on that local computer and browse to http://[name of server]/
[MyPortal]. It should display the same portal page as in the last step. This URL is the also the
one to use for the Elasticsearch destination file in the Flare project.

What’s Next?

The next steps in the process involve integrating Elasticsearch with Flare. Once those are complete,
you’ll be able take advantage of the full capabilities of Elasticsearch as your search engine. See
"Enabling Elasticsearch in the Target Editor" on the next page.
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Enabling Elasticsearch in the Target Editor
Follow these steps to configure Elasticsearch for your server-based HTML5 target.

How to Enable Elasticsearch
1. Open the target and click the Search tab.

2. Click the drop-down in the Type field and select Elasticsearch.
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3. Configure the following options you need to enable Elasticsearch for your output.

Search Results

Results per page You can change the number of search results that appear on each
page. This makes it easier to navigate between pages of search
results and improves loading times, especially for users who
access output from a mobile device. Setting a reasonable number
of results per page also makes it easier for search indexing
services (i.e., spiders, crawlers, or bots) to locate pages in output,
improving search results. You can set between 1-100 search
results per page.

Fragments per
result

This sets the number of fragments that contain the text of the
searched item shown in the preview text. The fragment level can be
set anywhere from 0-5. This applies to both search results and
Autocompletion Types. For example, if you type in the word
"Search" in the search bar, the search result extract might display
like this:

n "Search can be conducted from multiple locations. There are
three types of searches that can be selected in the Target
Editor. Use the search bar to locate the feature you want to
use."

n In this case, the Fragments Per Limit level is set to 3.

Fragment
character limit

This sets the character limit of the fragment phrase used in the
search.

Include stop-words
in search

Flare has a hard-coded stop words list that works behind the
scenes to filter out common structure-class words (i.e., function
words) from search operations. This means the Flare search
engine excludes words (e.g., "an," "for," "of," and "the") by default. If
you want the search engine to search for queries with these words,
you can include the stop words list in search.
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Partial word
searching

This allows part of a word to be searched in the target database.
For example, the string "sear" could return results for "search." The
Minimum word size field can be set from 3-10.

NOTE Enabling this setting could increase the build time
and the size of the search index for your target.

Advanced Search Options

Include Importance
(recommended)

In HTML5 output, the Flare search engine uses a combination of
factors to rank search results. The search engine considers the
number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate
results. You can turn off Importance and search using only the
number of search term hits in each topic. This is not recommended
unless you have one topic that is linked too many times that it
would skew your search results.
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Include fuzzy
matches

Fuzziness is when two words are spelled similarly and could be
considered the same word.

n Substitution: tabs could be construed as tags

n Insertion: tab could be construed as table

n Deletion: server could be construed as sever

n Transposition: file could be construed as flies

n Multiple edits: imeg > image. The first edit substitutes e for i.
The second edit inserts e at the end of the string to find the
word image.

By enabling this setting, this allows the following fuzzy matches:

n Zero edits for strings of one or two characters (i.e., to, by, on)

n One edit for strings of three to five characters (i.e., rnu could
be construed as run, hleps could be construed as helps)

n Two edits for strings greater than five characters (i.e., sievrly
could be construed as severely)

NOTE Sometimes a search string is stemmed when
displaying the search results. Stemming is when a word is
reduced to its root. For example, say you enter a search
criteria for "important." If this word is stemmed, then
Elasticsearch may return fuzzy matches for "importing."
This occurs because the initial search criteria has been
stemmed to the root "import."
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Featured Snippets

Filter Select to control which pieces of micro content to include in the
featured snippets area.

n Do not include in search results No micro content is included
in the featured snippets area.

n All micro content files Every phrase from all of your micro
content files may be included.

n Specific micro content files In the drop-down(s), choose one
or more micro content files. Every phrase from those files
may be included.

n Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values.
Micro content phrases that match may be included.

Limit number of
results

Control the maximum number of micro content responses that are
allowed to display in the featured snippets area. If you leave it set
at 1, Flare displays only the best match from your micro content
file(s); if you enter 3, Flare displays up to the best three matches (if
that many exist).
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Knowledge Panel

Filter Select to control which pieces of micro content to include in the
Knowledge Panel.

n Do not include in search results No micro content is included
in the Knowledge Panel area.

n All micro content files Every phrase from all of your micro
content files may be included.

n Specific micro content files In the drop-down(s), choose one
or more micro content files. Every phrase from those files
may be included.

n Micro content with meta tags In the additional drop-down(s),
choose specific meta tag names and corresponding values.
Micro content phrases that match may be included.

Limit number of
results

Control the maximum number of micro content responses that are
allowed to display in the Knowledge Panel. If you leave it set at 1,
Flare displays only the best match from your micro content file(s);
if you enter 3, Flare displays up to the best three matches (if that
many exist).

Auto-complete Results

Enabled This option enables the other options in this area. If this box is not
checked, all of the other options in this area are disabled.

Number of results This field sets the limit of personal searches that display in the
drop-down while entering the search string. This can be set from a
value of 1-25.

Include project
content

This displays the topic title, the path of where the topic resides in
your project, and the file name based on the search criteria. These
results are displayed with a topic icon.
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Include search
history

This includes a mix of personal and global searches in the output.

Global search
threshold

This threshold determines the minimum number of times a term
must be searched from unique IP addresses before it becomes a
global search term. This threshold can be set from a value of 0-
10000.

n Assuming that this field is set to a value of 50, if the term
"autocompletion" is searched from 49 unique IP addresses
on your HTML5 output, "autocompletion" does not become a
global search term until that term is searched from a 50th
unique IP address.

Sitemap

Generate sitemap This box should be checked to generate the sitemap required for
Elasticsearch on your output.

Web URL This is the URL used for your published output.
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Administrator Tools

Target GUID This provides the key used to identify and link a target to the
corresponding Elasticsearch index.

NOTE Multilingual Elasticsearch publishing requires all
targets to use the same GUID. If the GUIDs in the targets
are different, you might have empty targets on the portal or
experience a publishing failing with error 400. If necessary,
open targets in the Internal Text Editor to modify the GUID.

Generate GUID This generates the key to be used by the target for the
Elasticsearch index.

Launch Content
Services

This opens the target in the content services portal. You can
manage your targets, and search indexes in the portal.

4. Click to save your work.

TIP If you are producing different versions of your online output and using Elasticsearch,
you probably want to create a target with a different name for each version. Then, generate
a unique GUID for each of those targets.

The reason for this is that a search database/index is created for each output. If those
outputs share the same GUID, all the outputs will share the same search results, which
would could cause problems, because some outputs might have content that is not
actually available in other outputs.

Also, the paths to the topics linked in search results are also stored in the index. If you
change the path of a topic between the versions, the search result paths will also be wrong.
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Creating Destination Files for Elasticsearch
Elasticsearch is tied to your target—and therefore your output—through the use of publishing
destinations. You must create both a primary destination and an Elasticsearch destination. With the
primary destination, you tell Flare where to send your output files. With the Elasticsearch
destination, you specify where your search indexing data should be stored (i.e., the server location
that is set up by your network administrator).
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How to Create a Primary Destination File
1. In the Project Organizer, right-click the Destinations folder and select Add Destination.

2. Give the file a name and click Add.

3. Complete the fields in the Destination Editor, depending on how you want to transfer a copy
of your output files to their destination (e.g., FTP, SFTP). For more about the available
options, see the online Help.

4. Click to save your work.

NOTE You have the option in the Destination Editor to choose “File System” as the method
for transferring files. In this case, you would be storing the copy of your output files to a
local folder instead of transferring them remotely. You might choose to do this if you prefer
to use a third-party tool to then move those files up to the server hosting your output.

If you choose to publish your files locally in this way, you must have Java Development Kit
(JDK) version 8 installed. See the following:

https://www.madcapsoftware.com/downloads/java.aspx

How to Create an Elasticsearch Destination File
1. In the Project Organizer, right-click the Destinations folder and select Add Destination.

2. Give the file a name and click Add.

3. In the Destination Editor, click the drop-down arrow for the Type field and select
Elasticsearch.

4. Enter the Search Destination URL. This is the location provided by your network administrator
where the search index files will be uploaded for your output.

5. Click to save your work.
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Associating Elasticsearch Destinations With a
Target
Now that the Elasticsearch destinations have been created, you need to associate them with your
HTML5 target.

How to Associate Elasticsearch Destinations with a
Target

1. From the Project Organizer, open the target that you want to associate with the destinations.

2. Click the Publishing tab.

3. Click the check box in the Publish column next to the primary destination file that you
created.

4. Click the drop-down arrow in the Elasticsearch Destination column and choose the
Elasticsearch destination file that you created.

NOTE Elasticsearch destinations will not display in the list of destinations on the
Publishing tab in your Target Editor. This is because you will select one from the
Elasticsearch Destination field on the Publishing tab of the Target Editor.

5. Click to save your work.
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MadCap Process Manager
The Process Manager is a background process that manages the Elasticsearch service and the
Flare web service. This process can be found in the system tray. It is initiated when the Content
Services Portal is launched. See "Content Services Portal" on the next page.

The MadCap Process Manager continues to run even after Flare is closed. This process allows any
Elasticsearch output to continue running.

If you need to troubleshoot your Elasticsearch output, you will need to stop the Elasticsearch
process from running through the MadCap Process Manager. In order to do that, find the MadCap
Process Manager icon in your system tray. Then, select Elasticsearch Service > End Process.

Once you are done using the Content Services Portal or any output configured with Elasticsearch,
you can end the MadCap Process Manager by ending the task. Select the MadCap Process
Manager icon in your system tray. Then, select Content Services > End Process.
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Content Services Portal
The Content Services Portal is used to manage search indexes on your Elasticsearch output. You
can review and manage search indexes by topic, micro content, user searches, and global
searches.

How to Access the Production Content Services Portal
Installation and configuration of the Content Services Portal results in a URL for the portal. To
access Content Services on the production server, you can enter the URL into a web browser. For
example, the URL to use from another computer to access this portal is http://[name of server]/
[MyPortal]. See "Optional—How to Verify Content Service Portal Installation" on page 98.

How to Access the Local Content Services Portal
The following steps describe how to open the local version of Content Services. You might want to
do this to test the portal locally.

1. Open a project.

2. Open an HTML5 target that has been built using Elasticsearch as the search engine.

3. Click the Search tab.

4. After all of the settings have been configured for Elasticsearch, click the Launch Content
Services button.
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Managing Search Indexes
The All Targets window displays all HTML5 targets using Elasticsearch. You can access search
data by an individual target. Each of the columns on this window can be sorted in ascending or
descending order by clicking on the column name.

When you click an individual target, the Summary window is displayed for it. This window shows
the total number of searches done, number of files that can be searched, and users that have
searched on the individual target. The bottom half of this window displays the settings you
configured for your Elasticsearch output.
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If you click the red Topics button in the top left corner, the Topics window displays the total number
of files searched on this target. You can enter a string in the search field to filter the list of files
displayed.
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When you click the purple box in the portal, the Micro Content window displays all of the phrases
and the corresponding content that responds to each phrase. Each box in this window contains the
phrase, the date the micro content was created, and its corresponding response.
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Clicking the blue button displays the number of user searches for the specific target. This window
displays the search criteria from each individual search, the date of the search, along with the
IP address of the user who conducted the search. Each of the columns can be sorted in ascending
or descending order by clicking on the column name. You have the option to delete individual
search criteria, or delete all of the individual user searches for your target.
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The Global Searches window is displayed when you click the green button labeled Global Searches
anywhere in the portal. The Global Searches window shows each search criteria, the last time that
criteria was searched, along with the number of times that particular search string has been
searched for your Elasticsearch output. The number displayed in the Search Count field increments
higher when a specific string is searched by different IP addresses. So if the same IP address has
searched a certain search string multiple times, the search count number does not increment
higher for that particular IP address. Each of these columns can be sorted in ascending or
descending order by clicking on the column name.
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Importing Data From an Upgrade
If you are upgrading Elasticsearch from 5.6 to 7.10.2, you will see a large Import Data button in the
portal after you open a target.

NOTE If you have do not yet have data for Elasticsearch 7.10.2, you should see the large
Import Data button. This button will go away after your first import. There is also a smaller
import button at the top of the portal.
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Upgrading Elasticsearch and Content Services
on a Remote Server

Information for Network Administrators

Periodically, you might need to upgrade Elasticsearch or Content Services, or both.

How to Upgrade Elasticsearch From 5.6 to 7.10.2
1. Navigate to the Elasticsearch folder at the location where you have Flare installed (e.g.,

C:\Program Files\MadCap Software\MadCap Flare 19\Flare.app\Resources\Elasticsearch).

2. Copy this Elasticsearch folder from your local machine to the remote server and rename it
Elasticsearch7.x.

IMPORTANT This folder can be copied anywhere on the remote server, but the rest
of these steps are written assuming you have copied it to the root C:\ drive. It also
assumes your existing Elasticsearch folder for 5.6 that you previously copied during
the initial Elasticsearch installation is located on the root C:\ drive as well.

3. On the remote server, launch the command prompt (CMD) as an admin and run the following
commands:

n cd c:\Elasticsearch\bin

n elasticsearch-service.bat stop

n elasticsearch-service.bat remove

NOTE The three commands above are used to remove the Elasticsearch 5.6 service.

n cd c:\Elasticsearch7.x\bin

n elasticsearch-service.bat install
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NOTE The two commands above are used to add the Elasticsearch 7.10.2 service.

4. Using Windows Explorer, do the following:

a. Navigate to c:\Elasticsearch\config\elasticsearch.yml (the file that has been used for
Elasticsearch 5.6).

b. Open the elasticsearch.yml file in a text editor.

c. Under the Network section, find the string “http.port: 9200” and change the port to
something other than 9200 (e.g., 9205).

d. Save your changes in this file.

5. Using Windows Explorer, do the following:

a. Navigate to c:\Elasticsearch7.x\config\elasticsearch.yml (the file that will be used for
Elasticsearch 7.10.2).

NOTE You might also need to open the properties for this file and remove the
Read-Only check mark.

b. Open the elasticsearch.yml file in a text editor.
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c. Under the Network section, find the string “http.port: 9200” and remove the # character
from it. Leave the port number at 9200.

d. On the last line of the file (i.e., the whitelist), remove the # at the beginning of the line.
Also, change the number to match the configured port for the Elasticsearch 5.6 file
(e.g., 9205).

e. Save your changes in this file.

6. In the command prompt, run the following commands:

n elasticsearch-service.bat start

n cd c:\Elasticsearch\bin

n elasticsearch
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NOTE This will run the Elasticsearch 5.6 service in a console and won’t be part
of Windows Services. Do not close the command prompt, which would stop the
Elasticsearch 5.6 Service.

7. Continue with the next set of steps to upgrade Content Services.
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How to Upgrade Content Services From .NET Core 3.1
to 6.0.13
If you have upgraded Elasticsearch, you also need to upgrade Content Services. There might be
other times when you need to upgrade Content Services only.

1. On the remote server, open the Internet Information Services (IIS) Manager, and stop the
service.

2. Download and install the Microsoft .NET 6.0.13 Windows Hosting Bundle from the following
link.

https://dotnet.microsoft.com/download/dotnet-core

3. On the local machine, navigate to the Web.ContentServices folder at the location where you
have Flare installed (e.g., C:\Program Files\MadCap Software\MadCap Flare
19\Flare.app\Resources\WebHelp2\ContentServices\Web.ContentServices).

4. Copy and paste this Web.ContentServices folder to the remote server. It can be pasted
anywhere on the remote server. This is just a temporary folder that you will use in the steps
below; you can delete this folder later.
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5. Upgrade the Content Services portal. The older files referenced in the following sub steps
have to do with those you copied to C:/inetpub/wwwroot, as described in Installing
Elasticsearch on a Remote Server. So navigate to C:/intepub/wwwroot.

a. Keep the following folders in the older Web.ContentServices folder (located under
C:/inetpub/wwwroot):

n Logs

n Targets

n Uploads

Remove the other folders.

b. Keep the following files in this Web.ContentServices folder:

n appsettings.json

n Indices.db

n web.config

Remove the other files.

c. Copy all of the new folders and files (except appsettings.json and web.config)from the
temporary Web.ContentServices folder to the old Web.ContentServices folder.

6. Open the appsettings.json file. Add a comma at the end of the ElasticsearchURL line. Then
paste the following under that line (assuming the port number you entered previously is
9205):

"LegacyElasticsearchUrl": "http://localhost:9205"
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7. Save your changes in this file.

8. Open the IIS Manager and start the service.
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Import Data From Elasticsearch 5.6 to 7.10.2
1. Launch Content Services (i.e., the URL to your server where Elasticsearch is installed).

2. Open a target from the grid.

3. Click Import Data.

NOTE If you have do not yet have data for Elasticsearch 7.10.2, you should see the
large Import Data button. This button will go away after your first import. There is
also a smaller import button at the top of the portal.

4. In the popup, click Import Data again.
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You should see the tiles populated with numbers, representing your imported data.
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Google Search
Supported In:

Google Search can be used in your HTML5 Top Navigation or Side Navigation output. It provides
many configurable options.

n Verify the URL

n Add a sitemap

n Submit the site for indexing

n Exclude the TOC from indexing

n Customize how the results display

n Review indexing status

IMPORTANT If you implement Google Search, your Flare output will be available publicly
and listed in Google searches. To make your published output private, please refer to
Google’s documentation.
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How to Set Up a Google Search Engine
1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine field, select Google Search.

4. There are several additional steps you can complete in your Google account to optimize your
search. Not all of these extra steps are required for integrating search with Flare, but they are
recommended. Also, the exact steps that you follow may be somewhat different if you are
using a free Google account as opposed to a paid account.

GOOGLE ACCOUNT—CREATE SEARCH ENGINE

a. Go to cse.google.com and log in with your Google (i.e., gmail) password.

b. Click Add to create a custom search engine.

c. In the Sites to search field, enter the URL for the site where your output will be
published. A name for the search engine is automatically added toward the bottom of
the page, based on your URL. You can edit the name to something more simple if you
want.

d. Click Create.

e. On the next page, click Get code to retrieve your search engine ID.

f. Copy the search engine ID shown.

g. Continue with the following Flare steps to enter the Google search key and generate a
sitemap.
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FLARE PROJECT—ENTER GOOGLE SEARCH KEY AND GENERATE SITEMAP

a. Return to the HTML5 target (Search tab) in the Flare project.

b. In the Google Search Context Key field, paste the ID that you copied from
cse.google.com.

c. To assist with indexing, we also recommend that you create a sitemap. So Click
Generate Sitemap and enter the same URL that you provided on your Google account
page (make sure you include http:.// before the path; also, make sure you end the path
with a closing /).

d. Click to save your work.

e. Generate the target and upload the output files to your URL.

f. Continue with the following steps to verify your URL.
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GOOGLE ACCOUNT—VERIFY URL

a. In your browser, open a new tab and go to
https://www.google.com/webmasters/tools/.

b. If you do not yet have a site, click the Add property drop-down, then select the Add
property option.

If you already have a site, click the drop-down next to the site name, then select the Add
property option.

c. Enter the URL for your site, and click Continue.

A page opens with steps for verifying your site.

d. Complete the steps on the page.

e. After you have successfully verified the site, continue with the following steps to add
your sitemap.

GOOGLE ACCOUNT—ADD SITEMAP

a. After verifying the URL, click Go to Property.

b. Click Sitemaps.

c. Enter Sitemap.xml.

d. Click Submit.

e. Continue with the following steps to submit the site for indexing.

GOOGLE ACCOUNT—SUBMIT SITE FOR INDEXING

a. In the Google Search Console, click URL inspection.

b. In the text field, enter a page in your output that contains many links. For example, in
the Top Navigation project template in Flare, the “Home.htm” topic is the landing page
and contains links to multiple topics, so in that case you would enter
Content/Home.htm in the field.

c. Click Request indexing.

d. After the status finishes processing, close the message.

e. Continue with the following steps to exclude your TOC from indexing.
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GOOGLE ACCOUNT—EXCLUDE TOC FROM INDEXING

By default, Google will index each word it finds on your pages, but there may be some words
that you do not want to be indexed. This likely includes your TOC. After all, the words in the
TOC will be repeated on most, if not all, of your pages. So it wouldn’t be useful for those
words to be included in searches.

a. Go back to the first browser tab for your Google account and click the Advanced tab.

b. Click CSE context to expand that section.

c. Click Download (XML). The cse.xml file is added to the Downloads folder on your
computer.

d. Edit the downloaded context file cse.xml to add the following attribute: enable_
nocontent_tag="true". (If you already see this attribute in the file, you do not need
to add it.)

To add the attribute, you can open the file in a text editor such as Notepad++. Then
near the top of the file, change:

<CustomSearchEngine id= "[id]" creator="[id]">

to

<CustomSearchEngine id= "[id]" creator= "[id]" enable_
nocontent_tag="true">

There may be other attributes that are already in the tag as well. Save your changes
when finished.

EXAMPLE Here is an example of an edited cse.xml file:

e. On your Google account page, go back to the CSE context section of the Advanced tab,
and click Upload XML file.
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f. Choose the cse.xml file that you edited.

g. In the popup, click OK to upload the file.

h. Continue with the following steps to customize the appearance of search results.

GOOGLE ACCOUNT—CUSTOMIZE APPEARANCE OF SEARCH RESULTS

By default, search results are overlayed on top of your output. You can change this look if you
want.

a. Click Look and feel.

b. On the Layout tab, select an option.

NOTE In your Flare output, the results layout that you select may not look
precisely the way that Google presents them in the layout thumbnails. It is
recommended that you try different layouts and test the output to see which
one best meets your needs.

TIP To make the search results appear the way that they normally do in Top
Navigation output, select Results Only.

c. Click Save.

GOOGLE ACCOUNT—REVIEW INDEXING STATUS

From your account, you can see the progress of your indexed pages.

a. Go back to the browser tab showing your Google Search Console.

b. Click Sitemaps.

It might be awhile before you see actual results, so return to this page periodically.

5. Click to save your work.
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CHAPTER 5

Setting Search Results Options
For online targets, you have a variety of options that you can enable or disable to define how search
results are treated, depending on the output type.

This chapter discusses the following:

Setting the Number of Search Results Per Page 135

Setting the Search Abstract Character Limit 137

Including Stop Words in Search 139

Setting Search Result Importance 146

Enabling Partial-Word Search 150

Setting Micro Content Containers 152

Including Glossary Terms in Search Results 153

Excluding Non-Words From Search 157

Excluding Index Entries From Search 158

Pre-Merging Search Database Files 159

Chunking Large Search Database Files 160

Setting the N-Gram Size for Search 164
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Setting the Number of Search Results
Per Page

Supported In:

You can change the number of search results that appear on each page. This makes it easier to
navigate between pages of search results and improves loading times, especially for users who
access output from a mobile device. Setting a reasonable number of results per page also makes it
easier for search indexing services (i.e., spiders, crawlers, or bots) to locate pages in output,
improving search results. In order to use this feature, you must be using MadCap Search. This
feature is not supported for Google Search (see "Setting Up a Search Engine" on page 49).
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How to Change the Number of Search Results
per Page

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine section, make sure either MadCap Search or Elasticsearch is
selected.

4. In the Results Per Page field, use the arrows to set the number of results you want to display
on each page. By default, the number of results per page is 20 for MadCapSearch and 100 for
Elasticsearch.

5. Click to save your work.
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Setting the Search Abstract Character
Limit

Supported In:

In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search
results, while keeping the search results page easy to scan. You can set the character limit as long
or as short as you like. When creating an automatic abstract, Flare scans all text elements in the
topic, including headings and paragraphs, and includes them in the abstract until the character limit
is met.
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How to Change the Abstract Character Limit in
Search Results
If you want change the abstract character limit, do the following.

1. Open an HTML5 target.

2. Select the Search tab.

3. Select MadCap Search in the Search Engine field.

4. In the Abstract Character Limit field, enter the number of characters you want to allow in the
topic's abstract. By default, the number of results per page is 300.

5. Click to save your work.

NOTE In order to use this field, you must be using MadCap Search. Elasticsearch uses a
similar field called Fragment character limit. This feature is not supported for Google
Search (see "Google Search" on page 128).

NOTE Setting the abstract character limit to 0 will remove the abstract completely.

NOTE If a word is too long and would push the abstract past its character limit, it is not
included in the abstract. Flare will not leave incomplete words at the end of the abstract.

NOTE If you need to provide a longer or shorter search abstract, or if you do not like the
default text that appears in the abstract, you can manually enter a meta description for the
topic in the topic's Properties dialog.

See "Meta Descriptions for Topics" on page 169.

CHAPTER 5  138



Including Stop Words in Search
Supported In:

Flare has a hard-coded stop words list that works behind the scenes to filter out common structure-
class words (i.e., function words) from search operations. This means the Flare search engine
excludes words (e.g., "an," "for," "of," and "the") by default. If you want the search engine to search
for queries with these words, you can include the stop words list in search.
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List of Stop Words—English
Below is the list of hard-coded English stop words that the Flare search engine excludes from
search by default. If you want to create a custom stop words list, you can create one on your local
computer using Language Skins as described below.

a

about

after

against

all

also

among

an

and

are

as

at

be

became

because

been

between

but

by

can

come

do

during

each

early

for

found

from

had

has

have

he

her

his

however

in

include

into

is

it

its

late

later

made

many

may

me

med

more

most

near

no

non

not

of

on

only

or

other

over

several

she

some

such

than

that

the

their

then

there

these

they

this

through

to

under

until

use

was

we

were

when

where

which

who

with

you

your
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NOTE The stop words list applies to English projects only. If you wish to create a custom
stop words list for another language, use the instructions below to create a custom list of
stop words.

NOTE For best results, it is recommended that you use the default setting (i.e., stop words
are automatically excluded from search). This typically returns the most relevant search
results.

NOTE "If" and "will" are also recognized as stop words when using Elasticsearch as your
search engine.
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How to Include the Stop Words List in Search
By default, the words on the stop words list are excluded from search. To include them, complete
the following steps.

1. In the Project Organizer, open the target.

2. In the Target Editor, click the Search tab.

3. In the Search Results section, place a check mark in the Include stop-words in search box.

4. Click to save your work.

Creating a Custom Stop Words List
In Flare, the stop words list is hard-coded. However, you can create your own stop words list on
your local computer using language skins.

NOTE Stop words are not customizable in HTML5 outputs.
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How to Create a Local Copy of the Stop Words List
These instructions show you how to create a stop words list for an English language skin. You can
also use these instructions to create a custom stop word list for other languages.

1. Open a Flare project.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Add Language Skin.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Language Skin.

The Add File dialog opens.

3. In the File Type field at the top, make sure Language Skin is selected.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. From the Language drop-down, select the language you want to use for the language skin.

6. In the File Name field, type a new name for the language skin.

7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

9. Click Add. The language skin is added to the Advanced folder in the Project Organizer. The
Language Skin Editor opens to the right, with the new language skin shown. Depending on the
language you selected when creating the language skin, the skin may include default
translations for some UI text strings.

This creates a copy of the project language skin file and places it in your Project's Advanced
folder (e.g., C:\Users\[username]\Documents\My Projects\[project name]\Project\Advanced).
The language skin file name uses the *.fllng file name extension (e.g., af.fllng, en.fllng,
es.fllng).

10. Close the Language Skin Editor.
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How to Modify the Stop Words List
1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Right-click the language skin file, then select Open with > Internal Text Editor.

4. In the text editor, enclose your list of stop words in the <StopWords> </StopWords> tag. All
tags are case sensitive and all stop words must be typed in lowercase.

5. Enclose each stop word in the <Word></Word> tag.

6. Click to save your work.

NOTE You can also modify the stop words list using a text editor on your computer, such
as Notepad.
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How to Build the Target and Test the Custom Stop
Words List

1. Open the target in your Flare project.

2. Select the Language tab, and choose the appropriate language.

3. Build the target.

4. Perform searches in the output to test if stop words are being found.
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Setting Search Result Importance
Supported In:

In HTML5 output, the Flare search engine uses a combination of factors to rank search results. The
search engine considers the number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each topic. This is not
recommended unless you have one topic that is linked too many times that it would skew your
search results.  You must be using Elasticsearch or MadCap Search to use this feature. It is not
supported for Google Search.

How to Include or Exclude Importance in Search
Results

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.

4. Expand the Advanced Search Options section.

5. Select Include Importance.

6. Click to save your work.
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EXAMPLE Here is an example of a search with Importance turned on.

CHAPTER 5  147



Here is an example of a search in the same content with Importance turned off.
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Notice how the search results are different. This is because in the first example, with
Importance turned on, the search engine considers the number of links to that topic when
ranking the search results. In the second example, the results are ranked only using the
location of the search term in the topic (e.g., in a heading, in an index keyword, in the body
text).

If you want your users to be able to find a topic that you refer to—and link to—often in your
content, you should turn on the Importance setting so the topic appears higher in the
search rankings.

NOTE Links that occur in a template page are not considered when calculating
Importance. For example, suppose you have a link in the template page footer that appears
on every page in your output. Because you can access the page it links to from every other
page, it should be the most important page in the output, but it is excluded from
Importance rankings so it does not skew results.

CHAPTER 5  149



Enabling Partial-Word Search
Supported In:

For some online outputs, you can provide end users with partial-word search capabilities. This lets
users type part of a word or any string (including numbers), press ENTER or click the Search button,
and see search results matching those characters.

How to Enable Partial-Word Search
1. In the Project Organizer, open the target.

2. Select the Search tab.

3. In the Search Results section, place a check mark in the Partial word searching box.

4. In the Minimum word size field, enter the number of characters a user must type before
seeing results. The minimum value is 3, the maximum value is 10.

NOTE The higher the minimum word size that you enter, the smaller the search
database.

5. Click to save your work.
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EXAMPLE In the Search field, you enter cond.

Search finds matches in "conditioning" and "second."

IMPORTANT Enabling partial-word search in client-based outputs increases the size of the
search database included with your target output. It also increases the amount of time it
takes to build and publish the output.

NOTE This feature is not limited to words only. It works with any string (including
numbers) that starts and ends with a space. For example, let's say that the IP address
numbered "192.168.10.1" is included in one of your topics. To find the topic that includes
the match, simply type 10.1 in the search field.

NOTE Partial-word search is not supported in server-based output.
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Setting Micro Content Containers
Flare provides various container types that you can use to add micro content to your HTML5
output. Some of these can be used in search results, some in topic output, and some in both. See
the online Help for more information.
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Including Glossary Terms in Search
Results

Supported In:

For HTML5 output, search results display glossary terms if they are used as the search text. In
order to use this feature, you must be using MadCap Search. This feature is not supported for
Google Search (see "Setting Up a Search Engine" on page 49).
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How to Include Glossary Terms in Search
Results

1. Open an HTML5 target.

2. In the Target Editor, select the Search tab.

3. In the Search Engine field, make sure MadCap Search is selected.

4. Expand Advanced Search Options.

5. Select Include glossary results.

6. Click to save your work.

NOTE In order for a glossary term to display in the search results, the end user's search
text must match the glossary term exactly, with no additional words (although it is not
case-sensitive). For example, in the example above, only the word "table" was included in
the search; therefore, the glossary term "Table" was displayed. But if we had searched for
"table topic," no glossary term would have been displayed in the search results.
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NOTE If you open a Side Navigation, Top Navigation, Tripane, or Search Results skin, you
will notice Search Glossary styles that let you control the look of this new feature (e.g.,
change the font color to make it stand out from the other search results). The Search
Glossary Result style is used to control the entire area displaying the glossary search
result. The Search Glossary Term and Search Glossary Definition styles are used to control
the look of only the term and definition, respectively.
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Excluding Non-Words From Search
Supported In:

Flare has a non-words list that works behind the scenes to omit common non-words from user
searches (for example, angle brackets [ ]). When you set this option and a user enters non-words in
a search query, the system won't look for those non-words.

How to Exclude Non-Words From Search
1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.

4. Place a check mark in the Exclude non-words from search box. To include non-words in
search, clear the check mark.

5. Click to save your work.

NOTE This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Excluding Index Entries From Search
Supported In:

If you insert index markers in your project, those markers by default are included in searches that
users perform in your output. If you want to exclude index entries from searches, you can do so.

How to Exclude Index Entries From Search
1. Open the target.

2. Select the Search tab.

3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.

4. Click Exclude index entries from search.

5. Click to save your work.

NOTE This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Pre-Merging Search Database Files
Supported In:

If you have multiple projects and plan to merge their outputs when building the parent project, you
can pre-merge the search database files.

How to Pre-Merge Search Database Files
1. In the Project Organizer, open the target.

2. Select the Search tab.

3. Expand the Advanced Search Options section.

4. Place a check mark in the Pre-merge search database file box.

5. Click to save your work.
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Chunking Large Search Database Files
Supported In:

When Flare builds your output files, it also automatically generates a search index. The search
database is split into a series of chunk files with JS file name extensions. These "chunks" are very
important to your project, because they help to improve the performance of the search feature.

Search Database Files and Maximum Chunk
Size
Important things to know about chunk files include:

n Chunk Files are Automatically Created in Sequential Order The build process automatically
creates a search database and then splits the database information into individual chunks.
Each chunk is represented by a chunk file. The naming convention used for these files is
sequential (e.g., SearchPhrase_Chunk0.js, SearchPhrase_Chunk1.js, SearchPhrase_
Chunk2.js). After running a build, these files are required by the target output and stored in
the target's Output\Data folder.
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If you installed Flare in the default location, the path to the Output\Data folder is: C:\Users\
[user name]\Documents\My Projects\[project name]\Output\[user name]\
[target name]\Data

n There are Three Kinds of Chunk Files Search chunks come in three varieties: SearchPhrase
chunks, SearchStem chunks, and SearchTopic chunks. Each chunk type holds a different kind
of data. By separating search chunks into different files that contain phrases, stems, and
topics, Flare's search engine can locate data faster.

n Number of Chunk Files Depends on Project Content and Settings The total number of chunk
files generated by the build process depends entirely on the size of your project and the
search performance settings that you enable. As a general rule, smaller projects have fewer
chunk files than larger projects. Other factors to consider include the maximum chunk size
setting and whether the partial-word search feature is enabled. See "Enabling Partial-Word
Search" on page 150.

n New Chunk Files are Generated With Every Build When you update your content and build
new output files, Flare generates new chunk files to ensure your updated content can be
retrieved when end users perform a search. If you are publishing server-based output, always
ensure that your publishing and upload process for your output includes the updated chunk
files.
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How to Set the Maximum Chunk Size for Search
Database Files

1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. Expand the Advanced Search Options section.
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4. Place a check mark in the Chunk Large Search Database Files box. Then select a value in the
Maximum Chunk Size box.

NOTE The smallest maximum file size for a chunk file is 10,000 bytes. The largest
maximum file size is 100,000 bytes. The default setting for the maximum chunk file
size is set to 30,000 bytes.

5. Click to save your work.
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Setting the N-Gram Size for Search
Supported In:

N-grams can be applied to the search database to improve its ability to retrieve more accurate
matches for Chinese, Japanese, and Korean languages.

About N-Grams
In the English language, sentences are composed of a sequence of words. Because English words
are separated by spaces, search engines have a reliable pattern for detecting word boundaries
when retrieving search results. In other languages, such as Chinese, Japanese, and Korean, spaces
are not used to separate words. This makes the task of retrieving accurate matches for these
languages more challenging for search engines.

To address this issue efficiently, the search database can be set to use the n-gram model to help it
more accurately predict word patterns. This improves the search feature's ability to retrieve
accurate search results for the Chinese, Japanese, and Korean languages.
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How to Set the N-Gram Size
1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. Expand the Advanced Search Options section.

4. In the N-gram size box, select a value between 1- 5.

TIP Applying an n-gram value to a project affects the size of the search database. It
also affects the quantity and accuracy of the search results. In general, lower n-gram
values (e.g., 1-2) result in a smaller database. As a result, end user search queries will
typically retrieve a higher number results with less accurate matches. Similarly, larger
n-gram values (e.g., 4-5) result in a larger database. Therefore, search queries will
typically retrieve a smaller number of results with more accurate matches.

5. Click to save your work.
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CHAPTER 6

Generating Sitemaps
Supported In:

For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders,
crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine
results are improved.
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How to Generate a Sitemap
1. Open a web-based target.

2. On the Search tab of the Target Editor, select Generate Sitemap.

3. In the Web URL field enter the path where the output is ultimately published.

EXAMPLE https://help.madcapsoftware.com/flare2023 r2/

NOTE Be sure to include the full path—including "https://"—when entering the web
URL.

4. Click to save your work.

NOTE If you are generating HTML5 output, you can also set up your search engine—
MadCap Search, Google Search, or Elasticsearch (for Top Navigation, Side Navigation, or
skinless outputs). See "Setting Up a Search Engine" on page 49.
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CHAPTER 7

Optimizing Search
There are several optimization tasks you can follow to improve the quality of your search results.

This chapter discusses the following:

Meta Descriptions for Topics 169

Optimizing Content 174

Optimizing a Site 194

Ranking Search Results 201

Search Ranking 202
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Meta Descriptions for Topics
Supported In:

Description meta tags contain brief summaries of web pages and are recognized by all major
search engines. These tags might not factor into the search rankings by all search engines, but they
are still useful for search engine optimization in web-based outputs, because they can help with the
click-through rate in HTML5 output. We recommend that you create a meta tag set file, which adds
an empty description meta tag by default. This is faster than adding it separately to each topic. This
meta tag then becomes available at lower file levels (including topics), and you can then provide the
value in the topic properties.

CHAPTER 7  169



How to Add a Description Meta Tag Value for a
Topic

1. (Recommended) In the Project Organizer, expand the Advanced folder and add a new meta
tag set.

2. In the Content Explorer, right-click the topic file and select Properties.

3. Select the Meta Tags tab.

4. If you are using a meta tag set (recommended), expand it.

If you are not using a meta tag set, click to add a new text meta tag, which is added under
the Custom section. Then, enter description as the name.
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5. In the Value field, enter a description for the topic.

TIP When adding a value for a description meta tag, it is a good idea to ensure the
following:

n It should not be too long (fewer than 155 characters if possible) or too short.

n It should accurately reflect the contents of the page.

n It should contain relevant keywords, although you should never "stack"
keywords by simply repeating them.

n It should be unique (i.e., not the same description as you have in lots of other
topics).

6. Click OK.

This description is stored as metadata in the <head> tag of the topic file. The markup looks like this:

<meta name="description" content="This topic provides a general introduction to MadCap
Flare, its benefits, and basic steps for getting started." />

NOTE If you do not provide a meta description, Flare will use the abstract character limit to
create an abstract from the text in your topic.
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EXAMPLE A documentation team wants to enhance the overall experience for users to
find available information in their online Help system. They establish in-house guidelines
for how these meta tags should be constructed, and create brief descriptions of each web
page. The team sets out to increase content discoverability (which in turn should build user
trust, and increase brand awareness). They work to optimize text in search results for
HTML5 output—with the goal of increasing clicks and traffic.

LEVEL

They create a meta tag set, which automatically includes a description meta tag. They
leave the value empty, and add text at the topic level in the Properties dialog.

1. In the Project Organizer, right-click the Advanced folder and select Add Meta Tag Set.

2. Complete the File Name field and click Add.

3. When you want to provide the actual description text for a topic, open the Content
Explorer, right-click the topic, and select Properties.

4. In the Value field, enter a description for the topic.

5. Click OK.

This is an example of a description meta tag value shown in search results output.
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FINDABILITY
n SEO Description meta tags help to increase discoverability on the web. It is better to

add this tag for topics rather than leaving it blank or relying on a search engine to
auto-generate a description.

n Content Management In Flare, you might rely on the Used Meta Tags analysis report
or the File List window pane to view a list of files that show the description tags used
and their definitions.
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Optimizing Content
There are a variety of tasks you can perform to optimize your content. This includes adjusting topic
titles, heading tags, file names, index keywords, body text, and meta descriptions. You can also
determine whether or not the search engine considers how many internal links there are to a topic
when considering that topic's search result ranking.

Topic Titles
For Flare and for search engine providers, the topic title is one of the most important
considerations taken into account when ranking search results. Topic titles are important because
in addition to including important keywords, titles are also highly visible elements in search results.

Where Topic Titles are Visible:

n Flare Search Results

n Web Browsers

n Search Engine Results

n Social Media Bookmarks

Here are some recommendations for improving the quality of your topic titles for search
optimization:

n Give Each Topic a Unique Title Every page in your output should have a unique topic title. It
should also accurately describe the page content.

n Add Only One Title Per Topic A page should have only one title. For best results, it should be
contained in the <Title> tag. In Flare, you can set the topic title in the Topic Properties tab of
the Properties dialog. You have the option to always use the first topic heading as the title or
you can manually enter a topic title.
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EXAMPLE In the topic Properties dialog, you can use the first heading in each topic
as the topic title by default. When you use this option, the topic title is not included
within a <head> tag on the page.

You also have the option of manually typing a topic title in the Topic Title field of the
Topic Properties tab. When you use this option, the topic title is included in a <title>
tag within the <head> tag on the page.
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n Contain the Title Tag in the Head Tag Most search engine optimization (SEO) experts agree
that you can improve page rank if you include the topic <title> tag within the <head> tag.

EXAMPLE Below is an example of the HTML code for a topic title:

<head><title>Feeding a Cat</title></head>

In order for the title "Feeding a Cat" to appear in a <title> tag within the <head> tag,
open the Properties dialog for the topic. In the Topic Title field, type the title:

Below is an example of how the title appears in the Flare Text Editor:
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n Limit Title Length to 70 Characters Because topic titles display in search engine results,
experts recommend limiting page titles to a maximum of 70 characters, including spaces.
This increases the odds of end users clicking the link.

EXAMPLE Because titles display on search engine results pages, titles should be
limited to a maximum of 70 characters (including spaces).

n Place Important Keywords at the Front of the Title Tag For best results, order keywords in a
title from most important to least important. For example, if you anticipate that your end
users use query terms such as "Online Help Writing," it may be preferable to ensure the terms
Online and Help are at the front of the title tag. For example, "Writing Online Help" or "Online
Help Writing"
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n Place Keywords at the End of a Title If you want to include your company branding or project
name in a title, it is recommended that you place those keywords at the end of the title.

EXAMPLE If you want to include branding keywords, place them at the end of the
topic title.
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Heading Tags
Heading tags are important page elements. Below are some best practices for optimizing your
heading tags:

n Include Important Keywords in the <h1> Tag Because the text in the <h1> tags are used for
search categorization, they should always contain important search keywords.

n Limit <h1> Tags to One Per Page You should always apply the <h1> tag to the most important
heading text in a document. As a general rule, it is best to include only one <h1> tag per page.

n Keep <h1> Tags Unique Because search engines score unique pages higher, it is best that the
content of an <h1> tag is unique from other <h1> tags in a project.
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Index Keywords
Some search engines may also recognize the index keywords that you include. The Flare search
engine also looks at index keywords when ranking search results, so make sure that you insert
important keywords into your topics.

EXAMPLE Here is an example of an index keyword in the XML Editor.
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Body Text
The Flare search engine considers keywords in the body text when ranking search results. While the
search algorithm is different, major search engine algorithms also consider keywords in the body
text.

Best Practices for Body Text
Following are some best practices when it comes to body text.

n Include Keywords in the Topic Abstract For best results, carefully craft your paragraphs to
include your most important keywords in the first paragraph of the topic. Flare's search
engine places a high preference on keywords found in this paragraph, which acts as the topic
abstract.

NOTE If you use a meta description, the information in the meta description appears
in the search result instead of the topic abstract. See "Meta Descriptions for Topics"
on page 169.

n Use Important Keywords in Heading Tags You should always include the most important
keywords in the heading tags, as most search engines give headings more weight.

n Apply Emphasis to Keywords Some, but not all, search engines give preference to keywords
where bold or italics are applied. The Flare search engine weighs text with inline tags (i.e,
formatting applied with span tags) slightly higher than regular text.

n Consider the Frequency of Your Keywords Consider the number of times you use a keyword
on a page. Flare's search engine places gives preference to topics that use a keyword often.

n Include Hidden/Invisible Text You can optionally include hidden/invisible text as described
below.
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Hidden/Invisible Text
You can modify your project stylesheet if you want to include hidden/invisible text. This makes the
text invisible to the users viewing the topic, but it will be visible to the indexing programs used by
some search engines.

For the Flare search engine, it is acceptable to use invisible/hidden text to influence search results.

You might use hidden/invisible text on additional headings to give the topic more weight with
search engines.

IMPORTANT Be careful about using invisible/hidden text for the purpose of keyword
stuffing. For example, you should not include large blocks of hidden text in a topic because
it can lead to major search engine providers temporarily or permanently blocking your
content from their site. For that reason, it is recommended that you always research the
current content standards for your desired search engines.
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HOW TO CREATE A HIDDEN TEXT STYLE

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the drop-down field on the left, choose Heading Styles from the list. For this example, we
will show you how to create a hidden style class for your h1 tags.

4. Right-click the h1 and select Add Selector from the context menu.

The New Selector dialog opens.
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5. In the Class Name field, type a name for your style. In this example, we will name it
HiddenH1.

The new class appears in the stylesheet under the h1 tag.

6. In the Properties area, expand the Block properties.
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7. Next to the display field, click and select none from the drop-down list. Selecting none
here will let you see the element in the XML Editor and Text Editor. It will be visible to web
crawlers and spiders in the code, but completely hidden from your end users in the target
output.

8. Save your changes.
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HOW TO APPLY A HIDDEN/INVISIBLE TEXT STYLE

After you create a hidden/invisible text style, you can apply it to content, such as additional
headings. In this example, we show you how to apply the hidden style you just created to the first-
level heading.

1. Open the desired topic.

2. Add the text that you want to be hidden/invisible. In this example, we will add a duplicate
<h1> heading in a topic.

3. Right-click the structure bar to the left of the heading text and from the context menu, choose
Style Class > h1HiddenH1.
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The illustration below shows you how the hidden text style appears in the XML Editor.

4.  View the new style in your output.
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Meta Descriptions
You can use a text editor to add a meta description (summary or abstract) manually to a topic.
However, an easier method is to use the topic's Properties dialog in Flare to add them. Meta
descriptions are supported for HTML5, WebHelp, and WebHelp Plus targets. See "Meta
Descriptions for Topics" on page 169.

A meta description is typically not an important consideration for ranking results. However, many
(but not all) search engines display meta descriptions as page summaries in search results.

In Flare, meta descriptions are weighted heavily when ranking search results. In addition, meta
descriptions are used to display topic summaries on the search results page of the output. This is
also true for many, but not all, search engine providers.

If you include a meta description in a topic in an output type using the Flare search engine, the
description will always be displayed as the page summary in the search results, rather than of the
first paragraph of the topic.

EXAMPLE Below is an example of a meta description that has been added using the
topic's Properties dialog.
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If you decide to include a meta description for your topic, the text you write will appear in
the summary field of the Flare search results. The same is true for some, but not all, major
search engine providers.
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Guidelines for Writing Meta Descriptions
While not always used for ranking, most major search engine providers identify content with meta
descriptions as sign of higher-quality content. Also, because end users read meta descriptions and
make decisions as to whether or not to visit a page, it is generally a good practice to write meta
descriptions that satisfy these minimum guidelines:

n Create Readable and Well-Written Descriptions It is beneficial to add a high-quality meta
description to your topics. Just after the title on a search results page, a well-written meta
description can influence a person's decision to click to view a page. This, in turn, typically
improves the quality and quantity of page visits from internet search traffic.

n Provide Searcher with an Accurate Description of Page Content Think of a meta description
as part page summary and part advertisement. You want your descriptions to contain
descriptive keywords, and since it will also be displayed in search results, you want it to be
readable, concise, accurate, and to the point. A description should always provide a summary
of the content on a page. To avoid creating confusion, disappointment, or frustration for end
users, never load a meta description with repetitive keywords, inaccuracies, or promises that
they will find information that isn't actually in the body of the page.

n Contains Between 68-155 Characters Depending on which SEO experts you consult and
where you anticipate the page summary being displayed, you will find a wide variety of
recommendations about meta description length. The short answer is the different search
engine providers impose different limits. However, the Google limit is widely reported as
being 155 characters, so as a general guideline we recommend writing descriptions between
68-155 characters in length.

n Avoid Keyword Stuffing Although it can be tempting to repeat descriptive terms in a meta
description, there is little reason to include the same words and phrases multiple times. For
example, there is no need to stuff a meta description with keywords (i.e., "Toolbar, tool bar,
toolbars, tool bars"). First, this renders the description useless to anyone trying to read the
summary. Also, most major search engine providers will flag keywords in meta descriptions
as spam which can trigger ranking penalties and result in your page (or your entire site) being
disregarded by their search engine.
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File Names
Flare considers file names in rankings if you do not have a <title> tag in the document. When the
Flare search engine looks at the file names in your project, it considers the following when listing
results:

n Keyword Matches in File Names File names with exact keyword matches are favored. For
example, if you are searching for "choosing a cat," topics containing the keywords "choosing
a cat" will be ranked higher than file names containing "choose a cat" or "choosing cats."

n Do Not Run Keywords Together in File Names For best results with keyword recognition, it is
recommended that you do not run keywords together in file names (e.g., choosingacat.htm).
When keywords run together, there is a greater risk of the keywords not being recognized, as
well as not being parsed properly by search engines.

n Shorter File Names are Better Because file names are part of a URL, studies show that the
general rule of thumb for page URLs is that shorter URLs are better. For example, a file
named "choose-a-cat.htm" would be a more compelling link for an end user to click than a file
named "how-to-go-about-choosing-a-cat-or-a-kitten.htm."

n Use Hyphens While it is a common practice to use underscores in file names (e.g., Choosing_
a_Cat.htm), many search engine providers and SEO experts no longer recommend it because
the underscore is considered by some indexes to be its own word character. While it provides
visible separation between words, one point to consider is that some search engines might
take regular expressions such as "Choosing_a_Cat" and interpret it as "ChoosingaCat."
Because of this, some SEO experts recommend that you use hyphens to represent a space
between keywords. Whichever separator you decide to use, it is recommended that you do
not use periods (.) or blank spaces to separate words in file names. Periods are used by some
computer systems to indicate different file extension types. Blank spaces can cause issues
for Web servers, particularly those running UNIX or Linux.

n Be Aware of Case Because some major search engine providers run indexing systems on
case-sensitive servers (e.g., Apache, Unix, and Linux servers), whether a file name is written in
lowercase or uppercase can make a difference as to whether the file is indexed. For example,
a page named "choosing-a-cat.htm" may be interpreted differently from "Choosing-A-
Cat.htm." It can also lead to search engines creating duplicate page entries, which can result
in error codes when users click links, as well as penalties for content ranking. While it is
difficult to predict how each and every search engine will handle a file name, it is good to pick
your file naming convention wisely and then use it consistently.
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EXAMPLE You have a project with only five topic files. The file name for each topic uses a
different separator to represent the space between keywords (e.g., choosing a cat.htm,
choosing.a.cat.htm, choosing_a_cat.htm, and choosing-a-cat.htm. In addition, one of the
file names runs the keywords together (e.g., choosingacat.htm).

If you were to search for "choosing a cat," note how the search results will list only the
exact matches (i.e., the file name that runs keywords together is not detected as a match).
For example, "choosingacat.htm" is not listed in the results.
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Search Result Importance—HTML5 Output
In HTML5 output, the Flare search engine uses a combination of factors to rank search results. The
search engine considers the number of links to a topic (Importance) and the number of times a
search term appears in a topic. This gives you the most accurate results. You can turn off
Importance and search using only the number of search term hits in each topic. This is not
recommended unless you have one topic that is linked too many times that it would skew your
search results.

When optimizing your content for HTML5 output, consider if you are going to use Importance in
your searches and tailor your content appropriately. For example, if you plan to use Importance, you
should make sure you link to important topics throughout your output. However, if you do not plan
on using Importance in your searches, you should focus on adding keywords throughout your topic.

See "Setting Search Result Importance" on page 146.
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Optimizing a Site
You can take actions to optimize the site where your output is published. This includes generating a
sitemap, including a robots.txt file, enabling non-XHTML files in search, showing navigation links,
changing search pagination, and adding search abstracts.

Generating Sitemaps
For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders,
crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine
results are improved.

How to Generate a Sitemap
1. Open a web-based target.

2. On the Search tab of the Target Editor, select Generate Sitemap.

3. In the Web URL field enter the path where the output is ultimately published.

EXAMPLE https://help.madcapsoftware.com/flare2023 r2/

NOTE Be sure to include the full path—including "https://"—when entering the web
URL.

4. Click to save your work.
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Including a Robots.txt File
A robots.txt file is typically implemented by a website developer or website owners. It is used to
advise search engine robots and spiders about what site content can and cannot be crawled. The
robots.txt protocol is a simple text file that you can create in a text editor.

There are several reasons why you may want to consider creating a robots.txt file to use with your
published output:

n Block Access to Content If you do not want the robot or spider to crawl certain content, you
may want to publish those content files in a password-protected directory and include a
robots.txt file. It is recommended that you work with your website or web server
administrator to ensure your requirements are met.

n Block Access to Specific Files and/or Folders If you have specific content that want to block
from search engines, you can advise cooperating robots and spiders to exclude that content
from their index. Keep in mind that most major search engines cooperate with these
instructions. However, some search engines do not.

n Block Your Site from Specific Search Engines If you would like to block a specific search
engine from crawling your site, you can advise its robot or spider to exclude your site from its
index. To be successful, the robots.txt file must explicitly define the robot to block by name
and the spider must be programmed to cooperate with your instructions.
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How to Include a Robots.txt File
1. Open a text editor.

2. Create a new file and name it "robots.txt."

3. Include the desired instructions.

TIP To learn what to include in a robots.txt file, see http://www.robotstxt.org/. You
should discuss specific requirements with your web server administrator and/or
website developer.

4. Place the file at the root of the website hosting your published content.

EXAMPLE You plan to publish your Help content to a site named:

https://www.help.example.com

In this scenario, you should place the robots.txt file at the root of the site:

https://www.help.example.com/robots.txt

5. Publish your content and ensure the robots.txt file is still in place.

6. Test your robots.txt using a validation tool. Some major search engines provide their own
testing tools (e.g., Google) .
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NOTE Most major search engines (e.g., Google, Bing, and Yahoo) are known to
cooperate with the instructions in a robot.txt file. However, many search engines also
have the ability to discover information using other methods. For example, let's say
you have blocked a file named "form_1.html" in robots.txt. However, another website
has created a link on their site to your "form_1.html" page. In this scenario, the URL
for that linked page may be included in an engine's search results.

NOTE It is also generally understood that there are existing search engines, including
malicious ones, that do not cooperate with the robots.txt protocol. Be sure to work
closely with a web developer or your web host to ensure you get the best results
possible with your robots.txt file.
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Enabling Non-XHTML Files in Search
Because search engines have added non-HTML formats to their search indexes, it is helpful to
enable non-XHTML search in your output. This allows the Flare search engine to return matches for
non-HTML content in your project (e.g., PDF, DOC, and XLS files). You can enable non-XHTML
search in the HTML5 and WebHelp Plus server-based outputs. See "Including Non-XHTML Files in
HTML5 Search" on page 254.

Showing Navigation Links
You can add a navigation link to the top or bottom of topics in HTML5, WebHelp, or WebHelp Plus
outputs. This navigation link will not display unless the output topic is opened as a standalone
(outside of the main navigation framework of the output). By clicking the link, a user can view the
standalone topic in the main navigation framework.
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Changing the Number of Search Results Per
Page
You can change the number of search results that appear on each page in HTML5 outputs. This
makes it easier for users to navigate between pages of search results and improves search result
loading times, especially for users who access your output from a mobile device. In order to use
this feature, you must be using Elasticsearch or MadCap Search. This is feature is not suppoted for
Google Search. See "Setting Up a Search Engine" on page 49.
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Changing the Abstract Character Limit in Search
Results
In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search
results, while keeping the search results page easy to scan. You can set the character limit as long
or as short as you like. When creating an automatic abstract, Flare scans all text elements in the
topic, including headings and paragraphs, and includes them in the abstract until the character limit
is met. This feature is only supported for MadCap Search. See "Setting the Search Abstract
Character Limit" on page 137.

You can also add a manual search abstract using meta descriptions in the topic's Properties dialog.
See "Meta Descriptions for Topics" on page 169.
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Ranking Search Results
The Flare search database generates organic search results and looks at numerous signals,
factors, and metrics to determine how relevant the results are to the query terms. Understanding
how searches are ranked in the different output types helps you determine strategies for optimizing
your search results.

Ranking Results—HTML5, WebHelp
Flare's search engine uses content signals and content weighting to determine search rankings.

NOTE In HTML5 outputs, the Flare search engine uses one additional concept to rank
search results: Importance.

A topic's importance is determined by the number links to a topic in the output. A topic that
is linked from ten other topics is more important than a topic that is only linked from one
other topic. See "Setting Search Result Importance" on page 146.

Content Signals
When end users enter their query terms in output, the search engine looks at a variety of signals,
such as:

n Do the search terms occur in the topic title?

n Do the search terms occur in a heading tag, and at what level (e.g., H1, H2, H3)?

n Do the search terms occur in the abstract text or meta description?

n Do the search terms occur in an index marker in the topic?

n Do the search terms occur in a glossary term?

n Do the search terms occur in the topic's body?

n How many times do the search terms occur in each location (e.g., topic title, hyperlinks, body
text)?

These items are used to determine the topic's search ranking against other topics.
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Content Weighting
As with most search engines, Flare takes a variety of factors into account when ranking its search
results. Since retrieved results are relative to the search query and indexed content, the following
describes in general terms how different content elements are ranked.

Micro Content Search Results

If you create micro content, Flare considers only the text in the phrases and alternate phrases for
the micro content search results. The content in the response associated with each phrase is not
weighed. So the response that is paired with the phrase most closely matching the search query (or
having the most weight) is used. If you want to help boost a particular micro content
phrase/response so that it displays when a certain search term is used, you can add more
keywords to the phrase or alternative phrases for that response.

Regular Search Results

1. Title Tags

The topic title lets readers know the topic of a particular page. It is placed in a <title> tag,
within a <head> tag in HTML documents. You can add a topic title by right-clicking the topic
in the Content Explorer, and selecting Properties from the context menu. In the Properties
dialog, click the Topic Properties tab, and enter text in the Topic Title field.

You also have the option to leave the Topic Title field blank. If you do this, the first topic
heading will be used as the topic title by default.

Topics with a keyword in the <title> tag always appear first in search results, and always are
ranked higher than topics where a keyword appears elsewhere in the topic, regardless of how
many times the keyword appears. This helps you find the most expected topics when running
a search.

NOTE If you do not have a <title> tag in your topic, Flare uses the first heading in the
topic as the title tag for the file. If there are no headings in the topic, the file name
acts as the title tag. This text is given the same search ranking as a <title> tag.

2. H1 Tags
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3. H2 Tags

4. H3 Tags

5. H4 Tags, Index Keywords in Topics

NOTE If you do not want index keywords to be considered when retrieving search
results, you can exclude them from the search. See "Excluding Index Entries From
Search" on page 158.

6. H5 Tags, Glossary Terms

7. H6 Tags, Keywords in Body Text

8. Keyword Frequency

The search engine looks at how many times the search term appears in each topic. Topics
with frequent keywords are ranked higher than topics with fewer keywords.

NOTE While topics with more frequent keywords are ranked higher, they will never
outrank a keyword with a higher base weighting.
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EXAMPLE You have two topics that are almost identical. However, the search term
appears in a Heading 2 three times in the first topic and only two times in the second
topic. Because the search engine accounts for frequency, the first topic will appear
higher in the search results than the second topic.
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EXAMPLE You have two topics. In the first, your search term appears many times,
all in Heading 4s. In the second it appears once, in a Heading 3. The second topic will
appear higher in the search results because even though the search engine accounts
for frequency, search terms that appear in a Heading 3 still take priority over search
terms that appear in a Heading 4, regardless of how many total times they appear in
the topic.

NOTE Some search engines might also consider the text in a "description" meta tag that
you add for a topic (e.g., <meta name="description" content="Here is my description of this
topic." />). However, some search engines do not include this text in search rankings.
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Ranking Results—Server-Based HTML5 and
WebHelp Plus
If you enable server-based output for HTML5 or WebHelp Plus, the Flare the search engine is
supported by one of these tools:

n Microsoft Indexing Service To learn about the Microsoft Indexing Service, see Microsoft's
documentation. Here is a link to get you started:

http://technet.microsoft.com/en-
us/library/cc723263.aspx#XSLTsection123121120120

n Windows Search Service To learn about the Windows Search Service, see Microsoft's
documentation. Here is a link to get you started:

http://msdn.microsoft.com/en-us/library/windows/desktop/aa965362(v=vs.85).aspx

See "Enabling HTML5 Server-Based Output" on page 238.

Ranking Results—Eclipse Help
Search is provided by the Eclipse platform. You can configure a variety of different search options
in Eclipse. For more information, see the Eclipse documentation: help.eclipse.org.
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CHAPTER 8

Search Filter Sets
A filter can be included in the search feature to let users narrow their search based on concepts
that you have inserted into topics. Concepts are simply markers that you add to topics that have
some kind of relationship with each other. They are also used for inserting concept links into topics.

NOTE Search filters are not supported in Elasticsearch.

This chapter discusses the following:

Adding Search Filter Set Files to Projects 208

Importing Search Filter Sets 210

Opening a Search Filter Set 211

Inserting Concepts 212

Creating Search Filters 216

Customizing Search Filter Ordering 218

Associating a Search Filter Set With a Target 220

Search Filter Set Example 221

CHAPTER 8  207



Adding Search Filter Set Files to
Projects

Supported In:

The first step to using a search filter set is to add a special file for it to your project. A search filter
set file has an .flsfs extension and is stored in the Project Organizer under the Advanced folder.

How to Add a Search Filter Set
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Search Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Search Filter Set is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare, expand the
Factory Templates folder and click on a template file. If you want to use your own
custom template file, expand the appropriate folder and click on a file. For more
information about templates, see the online Help.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, type a new name for the search filter set.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

What’s Next?
After you add the new search filter set, you need to insert concepts into topics (if you have not
already done so). After that, you can create search filters based on the concepts that you inserted.
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Importing Search Filter Sets
Not only can you add new search filter sets, but you can also import an existing search filter set
(FLSFS file).

How to Import a Search Filter Set
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Search Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.

2. Select New from existing and click .

3. Find and select the FLSFS file that you want to import.

4. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.

5. If you want to give the search filter set a different name than that for the imported file, click in
the File name field and replace the text.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added and opens in the Search Filter Set Editor.
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Opening a Search Filter Set
The following steps show you how to open a search filter set that you have added to your project.

How to Open a Search Filter Set From the Quick
Launch Bar
The Quick Launch bar lets you search for any Flare file or command. It is located in the upper-right
corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any
available results appear in a drop-down list.

2. From the list, click the name of the file.

How to Open a Search Filter Set From the
Project Organizer

1. Open the Project Organizer.

2. Double-click the Advanced folder. The search filter sets in your project are displayed.

3. Double-click the search filter set that you want to open. The Search Filter Set Editor opens to
the right.
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Inserting Concepts
You can open a topic and use the top area of the Concept window pane to insert concepts into that
file.

Drag-and-Drop Method
Use this method to quickly insert a concept that already exists in your project.

n Advantage It is extremely fast.

n Disadvantage The concept that you want to insert must already exist in the project. This
means you must first insert the concept into a topic using one of the other methods.

How to Insert a Concept Using the Drag-and-Drop
Method

1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

3. In the bottom (explorer) area of the Concept window pane, click the concept and drag it to the
location in the topic where you want to insert it. As you drag the concept into the topic, a
vertical red bar acts as a guide to help you place the concept in the topic. The concept is
displayed within a marker in front of the word where you added it (as long as markers are
turned on). A marker can hold multiple concepts, but most times you only need one concept
per marker.

4. Click to save your work.
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Concept Window Pane Method
Use this method to insert a concept in the Concept window pane.

n Advantage It lets you continue to perform other tasks in the topic without having to "switch
modes."

n Disadvantage It is not quite as fast as the other methods.

How to Insert a Concept Using the Concept Window
Pane Method

1. Open the content file.

2. Click at the location where you want to insert a concept.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. Click in an empty field in the Terms column.

5. Type the concept as you want it to appear.

6. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

7. Click to save your work.
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Concept Entry Mode Method
Use this method to accomplish the same thing as the Concept window pane method. The
difference is that, with this method, you do not need to move your cursor from the topic to the
Concept window pane. You simply click at the spot in the text where you want to insert the keyword
and start typing. The words you type are added directly into the Concept window pane. This is a
good method to use if you plan to create concepts in a lot of topics all at once, without performing
any other tasks in the topic.

n Advantage It is extremely fast.

n Disadvantage If you are adding a concept as you work on a topic, you need to remember to
switch off the Concept Entry Mode so that you can return to editing your topic.

CHAPTER 8  214



How to Insert a Concept Using the Concept Entry Mode
Method

1. Open the content file.

2. In the local toolbar of the XML Editor click .

3. Click at the place in your topic where you want to add a concept.

4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.

NOTE As you type in the Concept window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you
are adding the concept. When you return to the XML Editor, the cursor returns to its
previous state.

5. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

6. If you want to add more concepts in the topic, repeat steps 3-5.

7. Click to save your work.

To turn off the Concept Entry Mode and return to regular editing, you can click again.

What’s Noteworthy?

NOTE If you want to see all of the concepts that you have inserted in your project, they are
displayed in the bottom portion of the Concept window pane.
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Creating Search Filters
After you add a new search filter set and insert concepts into topics, you can create search filters,
which let users narrow their search based on concepts that you have inserted into topics.

How to Create a Search Filter
1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed. See
"Adding Search Filter Set Files to Projects" on page 208.

3. Double-click the search filter set in which you want to create a search filter. The Search Filter
Set Editor opens to the right. By default, Flare provides you with an initial search filter called
"subset," which you can rename and use.

4. To create a new search filter, click in the local toolbar. A new search filter row is added,
with a temporary name for the search filter.

5. To enter a new name or comment for a search filter, do one of the following.

n Double-click in the appropriate cell and type the name or comment.

n Click once in the appropriate cell and press F2 on your keyboard. Then type the name or
comment.

6. To associate a concept with the search filter, click the Concepts cell. The Select Concepts for
Search Filter dialog opens. The concepts that you have inserted into topics are listed on the
right side of the dialog.

7. In the All Concepts section, click on a concept that you want to add to the search filter. Then
click .

The concept is added to the "Selected Concepts" section on the right side of the dialog. Do
this for each concept that you want to add to the search filter.

NOTE If you do not associate a concept with the search filter, the search filter will
not appear in your output.

8. Click OK.

9. Click to save your work.
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NOTE When merging projects in WebHelp and HTML 5 output, only the parent project's
concepts and search filter sets retained after the merge. You will not be able to find the
child project's topics even if the concept links are identical. A workaround is to create an
external resources folder that all the projects share and put the search filter set in that
folder. .
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Customizing Search Filter Ordering
Supported In:

By default, search filters display alphabetically. However, you can customize the ordering of the
search filter set so they display in the order that is most useful for your audience.
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How to Customize Search Filter Ordering
1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the order displayed in the output.

4. In the Filter Name column, select the filter you want to move.

5. To customize the order of the filters, do one of the following:

n Click or in the local toolbar.

n Select Move Up or Move Down from the context menu.

6. (Optional) To reset the search filters to alphabetical order, click .

7. Click to save your work.

NOTE You can create search filters for merged projects in WebHelp and HTML 5 output.
However, when you merge projects, ordered search filter sets are separated by project in
the output. To control the order of the search filters from all of your merged projects, you
can create an external resources folder that all the projects share and put the search filter
set in that folder.
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Associating a Search Filter Set With a
Target

After you create search filters, you need to associate the search filter set with the target that you
want to build.

How to Associate a Search Filter Set With a
Target

1. Open the target that you plan to build.

2. In the Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. Click to save your work.
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Search Filter Set Example
Concepts and search filters might seem a little confusing to you at first. The following example is
designed to help make these ideas clearer and guide you through the steps for creating your own
search filter by using concepts.

Scenario
Let's say we have a Flare project called "Pets." In this project, we have dozens of topics about all
kinds of animals (cats, dogs, parrots, hamsters, and so on). We have written five topics about dogs.
These are:

n Choosing a Dog

n Feeding a Dog

n Training a Dog

n Grooming a Dog

n Walking a Dog

We want our users to be able to search for information about dogs. However, we want to limit their
search to these five topics (so that they aren't bothered with seeing search results in other "non-
dog" topics). We'll use a concept to tie our five "dog" topics together, and then we'll customize the
search feature to include this concept.
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Step 1—Create and Insert a Concept
First, we need to create a concept to tie these five topics together. We can create a concept with
any name that we want, but it helps to name the keyword something that is obvious and all topics
have in common. Therefore, we'll give our concept the name "dogs."

1. Open any of the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topic where you want to insert the concept. Typically, you'll insert
the concept somewhere near the top of the topic. In our example, we will click right before our
topic title "Choosing a Dog."

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. The cursor should already be placed in the Terms cell. If not, click in that cell. Then type dogs
and press ENTER. A concept marker labeled "dogs" is added before the topic title. If you
cannot see the marker, you need to turn your markers on by clicking the down arrow next to
the Show tags button in the XML Editor. Then select Show Markers.
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Step 2—Copy and Paste the Concept Marker
Into All Relevant Topics
Next, we need to place the same concept marker in our other four "dog" topics. We could repeat the
same steps above for each topic, but we'll copy and paste our first concept marker instead.

1. In the "Choosing a Dog" topic, click on the concept marker and choose Select.

2. Press CTRL+C on your keyboard.

3. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic
title (or somewhere near the top of the topic), and press CTRL+V on your keyboard. Repeat
this until you've pasted the concept marker into all five of the "dog" topics.

Step 3—Add a Search Filter Set and Create a
Filter
Now that we have the concepts in place, we can create a search filter for the "dog" topics.

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Search Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Search Filter Set.

The Add File dialog opens.

2. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

3. Click in the cell under the Filter Name column until "My Subset" is highlighted. Type Dog
Topics and press ENTER.

4. Click in the cell under the Concepts column. The Select Concepts for Search Filter dialog
opens.

5. In the Selected Concepts section, double-click dogs. The concept is added to the "All
Concepts" section on the left side of the dialog.

6. Click OK.

7. Click to save your work.
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Step 4—Customize Search Filter Ordering
If you have created multiple search filters, you can rearrange them to best suit the needs of your
audience (in web outputs). By default, they are alphabetical, but you want to move the "dog" filter to
the top of the list.

1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the displayed order in the output.

4. In the Filter Name column, select the "dog" filter.

5. To customize the order of the filters, do one of the following:

n Click or in the local toolbar.

n Select Move Up or Move Down from the context menu.

6. (Optional) To reset the search filters to alphabetical order, click .

7. Click to save your work.
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Step 5—Associate the Search Filter Set With a
Target
Finally, we need to make sure the search filter set that we created is associated with the target that
we plan to build.

1. Open the target that you plan to build.

2. In the Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. Click to save your work.

Now when people use the search feature in our output, they can select "Dog Topics" from the Filter
field to limit their search to our five "dog" topics.

What’s Noteworthy?

NOTE Search filters are not supported in Elasticsearch.
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CHAPTER 9

Search Highlighting
Supported In:

When users initiate a search query, the search hits (i.e., the matching keywords and phrases) may
be highlighted when the individual topics are opened. This feature is called "search highlighting" and
it is supported for simple text search and phrase search. Note that when searching with wildcard
characters, the search feature will not apply highlighting to search hits.

This chapter discusses the following:

Search Highlighting in Online Outputs 227

Turning Off Search Highlighting in Flare's Output 228

Customizing the Highlight Color for Search Hits 229
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Search Highlighting in Online Outputs
Online output types use a highlight color when revealing search hits. HTML5 Tripane output shows
highlights words in color by default. In Side and Top Navigation outputs, search results are
transparent, but you can customize this, adding colors. See "Customizing the Highlight Color for
Search Hits" on page 229.

In Eclipse Help, search highlighting is provided by the Eclipse platform and cannot be changed
using Flare.
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Turning Off Search Highlighting in
Flare's Output

If you search in any of Flare's online Help systems and open a topic from the search results, terms
are automatically highlighted in the topic. To turn off the highlighting, click in the upper-right of
the topic.
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Customizing the Highlight Color for
Search Hits

Supported In:

When users perform searches in your online output, the keywords that are found may be
highlighted in the topics. The background for each term found in a topic can be highlighted in a
different color. In Flare you can use styles to change not only the color background, but other
settings as well (e.g., font style, text decoration).

Customizing the highlight color for search hits is useful when you want to coordinate the visual
elements of your online target with a color palette or scheme. It can also be used to improve the
accessibility of your documentation. For example, if you are developing a project for an audience
with impaired vision, you might want to customize the search highlighting to provide users with a
higher color contrast.

For most types of output, you can customize the highlight color using span styles (e.g.,
span.SearchHighlight1, span.SearchHighlight2) in a regular stylesheet. For HTML5 Tripane output,
this is done in the Skin Editor instead.
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EXAMPLE You have the following three classes: span.SearchHighlight1,
span.SearchHighlight2, and span.SearchHighlight3. For span.SearchHighlight1, you change
the background color to blue. For span.SearchHighlight2, you change the background color
to orange. And for span.SearchHighlight3, you change the background color to yellow.

If a user enters "topic information help find" in the search field, the term "topic" will be
displayed with a blue background everywhere it occurs in a topic. The term "information"
will be displayed with an orange background, and the term "help" will be displayed with a
yellow background. The term "find" will be displayed with the default background color
specified by Flare (since you did not change it).

If another user enters "help find topic information" in the search field, the term "help" will be
displayed with a blue background. The term "find" will be displayed with an orange
background, and the term "topic" will be displayed with a yellow background. The term
"information" will be displayed with the default background color specified by Flare (since
you did not change it).
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How to Customize Search Highlight Colors
1. From the Content Explorer, open the stylesheet that you want to modify.

2. Complete one of the following sets of steps, depending on whether you want to use the
Simplified view or Advanced view in the Stylesheet Editor.

n Simplified The Simplified view displays styles in a grid view and is often best for brand
new users.

This view provides an easy way to apply properties to styles, with format options
available from a toolbar and dialogs (similar to the way one would use an interface
such as Microsoft Word). In some cases, only the most common property options are
available in the Simplified view (e.g., font, letter/word spacing, paragraph
alignment/indentation, autonumbering format, borders, background). One advantage of
the Simplified view is that you can apply a property to multiple styles at the same time.
You can also click a check box to hide the properties in the editor, allowing you to see
only the styles.

n Advanced The Advanced view displays styles in a tree structure, and despite the name,
is user friendly for authors of all levels.

For the properties, you can toggle between a grouped display and an alphabetical
display. The Advanced view of the Stylesheet Editor lets you edit more settings than are
available in the Simplified view. In addition, the Advanced view lets you see and apply
settings to multiple mediums and media queries at the same time.

IF USING SIMPLIFIED VIEW

a. In the local toolbar, make sure the first button displays (which means
that the Simplified view is currently shown in the editor). If the button displays

instead, then click it.

b. In the upper-left corner of the editor, click in the drop-down field and select
.

c. (Optional) If you have an older stylesheet that does not yet contain the appropriate
span classes you need for search highlighting, you can create them. You can do this for
a main "SearchHighlight" class, as well as for the first 10 terms that users enter in the
search field, naming each class "span.SearchHighlight1," "span.SearchHighlight2," and
so on until you create "span.SearchHighlight10." The easiest way to create these
classes is to import them from a Flare factory stylesheet, but you can also create them
manually.
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TO IMPORT THESE CLASSES FROM A FLARE FACTORY STYLESHEET

i. In the local toolbar, click the Options button and select Import Styles. The Import
Styles dialog opens.

ii. In the Library Folders section, make sure Factory Stylesheets is selected.

iii. In the Stylesheets section, select SearchHighlight.

iv. (Optional) In the [Medium] drop-down list, you can select a specific medium. This
determines the medium to which the styles are imported in your current
stylesheet. If you select "default," the imported style properties will be applied to
all of the mediums in the other stylesheet. If you select a custom medium, the
imported style properties will be imported to that medium in the other stylesheet.

v. In the section below, click the Import check box next to each style class named
span.SearchHighlight followed by a number. There are 10 of these style classes.

vi. Click OK. The style classes are added to the current stylesheet.

TO CREATE THESE CLASSES MANUALLY

i. From the grid in the bottom portion of the Stylesheet Editor, select the span tag.

ii. In the local toolbar, click . The New Selector dialog opens.

iii. Enter SearchHighlight1 (or replace 1 with another number at the end, up to
10).

iv. Click OK.

d. Select the style class that you want to modify. If you select the main SearchHighlight
class, the same color will be used for all search terms found. Otherwise, you can select
a numbered SearchHighlight class (e.g., SearchHighlight1, SearchHighlight2) to set
individual colors for different terms found.

e. In the local toolbar of the editor, click . The Properties dialog opens.
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f. Use the Properties dialog to change values for the style's properties.

EXAMPLE You want to change the background color for the class
span.SearchHighlight1. After you select that class on the left you can select the
Font tab in the Properties dialog. Then click the down arrow in the Background
field and choose the color you want.

g. In the Properties dialog, click OK.

IF USING ADVANCED VIEW

a. In the local toolbar, make sure the first button displays . If the button
displays instead, then click it.

b. In the upper-left corner of the editor, click in the drop-down field and select
.

c. (Optional) If you have an older stylesheet that does not yet contain the appropriate
span classes you need for search highlighting, you can create them. You can do this for
a main "SearchHighlight" class, as well as for the first 10 terms that users enter in the
search field, naming each class "span.SearchHighlight1," "span.SearchHighlight2," and
so on until you create "span.SearchHighlight10." The easiest way to create these
classes is to import them from a Flare factory stylesheet, but you can also create them
manually.

TO IMPORT THESE CLASSES FROM A FLARE FACTORY STYLESHEET

i. In the local toolbar, click the Options button and select Import Styles. The Import
Styles dialog opens.

ii. In the Library Folders section, make sure Factory Stylesheets is selected.

iii. In the Stylesheets section, select SearchHighlight.

iv. (Optional) In the [Medium] drop-down list, you can select a specific medium. This
determines the medium to which the styles are imported in your current
stylesheet. If you select "default," the imported style properties will be applied to
all of the mediums in the other stylesheet. If you select a custom medium, the
imported style properties will be imported to that medium in the other stylesheet.

CHAPTER 9  233



v. In the section below, click the Import check box next to each style class named
span.SearchHighlight followed by a number. There are 10 of these style classes.

vi. Click OK. The style classes are added to the current stylesheet.

TO IMPORT CREATE THESE CLASSES MANUALLY

i. On the left side of the editor, select the span tag.

ii. In the local toolbar, click . The New Selector dialog opens.

iii. Enter SearchHighlight1 (or replace 1 with another number at the end, up to
10).

iv. Click OK.

d. Select the style class that you want to modify. If you select the main SearchHighlight
class, the same color will be used for all search terms found. Otherwise, you can select
a numbered SearchHighlight class (e.g., SearchHighlight1, SearchHighlight2) to set
individual colors for different terms found.

e. From the Show drop-down list on the upper-right side of the editor, select
.

f. (Optional) You can use the toggle button in the local toolbar to show properties below
in a group view or an alphabetical view .

g. Locate the property you want to change. Not only can you change the background
color, but you can change any other property for the class as well.

h. The area to the right of the property is used for selecting and entering values. If you
know how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on
the type of property, the appropriate controls and options display, allowing you to
choose or enter values (e.g., select from a drop-down list, click a button, complete
fields in a dialog or popup). If you completed values in a popup, click OK at the bottom
of the box.
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EXAMPLE You want to change the background color for the class
span.SearchHighlight1. After you select that class on the left you can open the
Background property group on the right side of the editor. Then to the right of
background-color, click , then choose the color you want.

3. Click to save your work.
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How to Customize Search Highlight Colors—
HTML5 Tripane Only
Use the following steps if you are creating HTML5 Tripane output. If you are creating HTML5 Side
Navigation, Top Navigation, or skinless output, use the steps above for doing this in a stylesheet.

1. In the Project Organizer, open the Skins folder.

2. Open the desired HTML5 Tripane skin.

3. In the Skin Editor, click the Styles tab.

4. On the left side of the editor, in the Search Results section, expand the Search Highlight style.

5. If you want the setting(s) to be applied to all of the items, complete the fields under the main
Search Highlight style itself. Otherwise, expand any of the child styles (Search Highlight 01 to
10) to apply settings to them individually. Each search highlight style is numbered to
coordinate with the order search terms are entered. For example, the style named "Search
Highlight 01" will be used for matches to the first search term entered and "Search Highlight
10" would coordinate with the tenth entered term. You can customize up to 10 highlight
colors.

6. Click to save your work.

What’s Noteworthy?

NOTE Search highlighting for Eclipse Help is provided by the Eclipse platform. Highlight
colors for search cannot be modified in Flare.
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CHAPTER 10

Server-Based Search HTML5
For HTML5, there are additional tasks that you can perform when producing server-based output.

This chapter discusses the following:

Enabling HTML5 Server-Based Output 238

Including Non-XHTML Files in HTML5 Search 254
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Enabling HTML5 Server-Based Output
You can create HTML5 output in its regular state, or you can select an option in the Publishing tab
of the Target Editor to enable server-based functionality.

If you want to take advantage of the advanced server-side features of HTML5 (i.e., automatic
runtime project merging, server-side search, searching of non-XHTML files), you must enable
HTML5 server-based output. This includes performing the following tasks: (1) installing Microsoft
Internet Information Services (IIS) and ASP.NET, (2) setting up the HTML5 target and
generating/publishing, (3) configuring IIS on the production server, (4) starting Microsoft Indexing
Service or Microsoft Windows Search (depending on the operating system), and (5) enabling
HTML5 search.

It is not necessary to install these in order to simply build HTML5 server-based output. However, if
you want to be able to view and display HTML5 server-based output, the following steps are
necessary. You must perform these steps on the machine that will be hosting the published HTML5
server-based output. If you want to view the output on your local machine to test the results, then
you also need to perform these steps on your local computer, except for the procedure "Configuring
IIS on Production Server."
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Installing IIS and ASP.NET
The following steps show you how to install IIS and ASP.NET, depending on the operating system.

Windows 8
The following steps show you how to install IIS and ASP.NET 4.5 for Windows 8.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management
Compatibility.

6. Click IIS Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET 4.5

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET 4.5 to add a check mark.

4. Click OK.
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Windows 7
The following steps show you how to install IIS and ASP.NET for Windows 7.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management
Compatibility.

6. Click IIS 6 Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET to add a check mark.

4. Click OK.

5. Click Start.

6. In the search field enter run.

7. Click Run. The Run dialog opens.

8. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i
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9. Click OK. A window opens, displaying the installation progress of ASP.NET. The window will
close automatically when the installation finishes.

Windows Server 2012
The following steps show you how to install IIS and ASP.NET 4.5 for Windows Server 2012.

INSTALLING IIS

1. Open the Server Manager.

2. Click Add roles and features. The Add Roles and Features Wizard opens.

3. Click Next two times until you ge to the Server Roles page.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Features.

INSTALLING ASP.NET 4.5

1. In the Add Roles Wizard click Next.

2. Expand .NET Framework 4.5 Features and click ASP.NET 4.5.

3. Click Next.

4. At the Web Server Role (IIS) tab, click Next again.

5. Expand Management Tools > IIS 6 Management Compatibility and click IIS 6 Metabase
Compatibility.

6. On the Confirm Installation Selections page of the wizard, click Install.

7. After the installation is completed, the Installation Results page opens. Click Close.
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Windows Server 2008 r2
The following steps show you how to install IIS and ASP.NET for Windows Server 2008 R2.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6
Management Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.

8. In the search field enter run.

9. Click Run.The Run dialog opens.
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10. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

11. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close
automatically when the installation finishes.

CHAPTER 10  243



Windows Server 2008
The following steps show you how to install IIS and ASP.NET for Windows Server 2008.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6
Management Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.
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Windows Server 2003
The following steps show you how to install IIS and ASP.NET for Windows Server 2003.

INSTALLING IIS VIA THE MANAGE YOUR SERVER DIALOG

1. From the Start menu open the Manage Your Server dialog.

2. Click Add or remove a role.The Configure Your Server Wizard opens.

3. Click Next.

4. Select Application server (IIS, ASP.NET) and click Next.

5. Click Enable ASP.NET and click Next.Your selections are summarized.

6. Click Next.The Windows Components Wizard opens, displaying the status of the installation.

7. After the installation is completed, click Finish.

INSTALLING IIS VIA THE CONTROL PANEL

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

2. Double-click Add or Remove Programs.The Add or Remove Programs window opens.

3. Click Add/Remove Windows Components.The Windows Components Wizard opens.

4. In the list of components select Application Server and then click Details.The Application
Server Dialog opens.

5. Click the check box next to Internet Information Services (IIS) to add a check mark.

6. In the Windows Component Wizard, "Application Server" should now be selected. Click Next.

7. Click Finish.
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INSTALLING ASP.NET

1. Click Start > Run.The Run dialog opens.

2. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

3. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close
automatically when the installation finishes.

NOTE ASP.NET pages by default are prohibited in IIS. Therefore, you must set these
pages to be allowed if you are running Windows Server 2003. To do this: (1) In
Internet Information Services (IIS) Manager, select Web Service Extensions from the
left pane; (2) in the right pane, make sure that ASP.NET v4.0.30319 is set to Allowed.
If it is not, select it and click the Allow button.
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Setting Up an HTML5 Target
The following steps show you how to set up your HTML5 target for server-based output.

How to Set Up the HTML5 Target
1. In Flare, open the HTML5 target.The Target Editor opens.

2. Select the Publishing tab.

3. In the Server-based Output section, click the check box.

4. In the Indexing Service Catalog Name field, type the catalog that you are using for the output.
In most cases, this will be Web, which is the default value. However, if you or someone in your
company (e.g., network administrator) creates a custom catalog, you need to enter that name
in the field.

What is a catalog? Microsoft Indexing Service stores all of its index information in catalogs. A
catalog comprises index information and stored properties for a particular group of file
system directories. If Internet Information Services (IIS) is installed, the Indexing Service also
creates a web catalog, which contains an index of IIS, the default virtual server of the World
Wide Web.

NOTE This step is necessary only for Windows Server 2003.

5. Click to save your work.

6. Generate the target.

7. Publish the output to any location on the web server. If you want to use the default location
that was created after you installed IIS, you can publish the output to C:\Inetpub\wwwroot. If
you do this, you can use the "Default Web Site" folder that you will encounter when
performing the next set of steps (i.e., configuring IIS on the production server).

If you are working on your local machine for testing purposes, you do not need to publish the
output. You can simply view your WebHelp Plus output. When you view HTML5 output on
your local computer, you need to create a special folder called "MCPreview" within your
"C:\Inetpub\wwwroot" folder. Place a copy of your HTML5 output files in it. This enables you
to test the advanced features of HTML5 on your local machine.
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Configuring IIS on Production Server
The following steps show you how to configure IIS, depending on the operating system. These
steps are necessary only for the server where you will be publishing the final output. It is not
necessary to perform these steps on your local computer for testing HTML5 server-based output.

Windows Server 2003
1. Open the Control Panel. On many computers, you can do this by clicking Start > Control

Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Internet Information Services.The Internet Information Services dialog opens.

4. Find your output folder and right-click the Service subfolder. Then select Properties.The
Service Properties dialog opens.

5. Select the Virtual Directory tab.

6. Next to the Application name field, click the Create button.

NOTE If this button has already been selected, it will display as "Remove" instead. In
this case, you do not need to click the button.

7. In the Execute Permissions drop-down, make sure Scripts only is selected. It should already
be selected by default.

8. Click OK.
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Windows Server 2008 and 2008 r2, Windows 2012,
Windows 7, and Windows 8

1. Open the Control Panel.

2. Select System and Security.

3. Select Administrative Tools. The various operating systems have different ways to find this
option.

4. Open the Internet Information Services (IIS) Manager.

5. Expand the node with the computer name.

6. Expand the Sites folder.

7. Expand the website folder corresponding to the one that you published.

8. Find your output folder and right-click the Service subfolder. Then select Convert to
Application.

9. Make sure the application pool is using the .NET 4 framework.

a. In the dialog click Select.

b. From the drop-down select an application pool that is using the .NET 4 framework.

c. Click OK.

10. Click OK.
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Starting Microsoft Indexing Service
The following steps show you how to start the Microsoft Indexing Service on machines that are
running Windows Server 2003. This procedure is not necessary for the other operating systems.

Windows Server 2003—How to Start Microsoft Indexing
Service

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control
Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Computer Management.The Computer Management dialog opens.

4. Expand Services and Applications.

5. Right-click Indexing Service.

6. In the context menu, click Start. The Indexing Service is now started.
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Starting Microsoft Windows Search
The following steps show you how to start the Microsoft Windows Search on machines that are
running Windows Server 2008. This procedure is not necessary for the other operating systems.

Windows Server 2008—How to Start Microsoft
Windows Search

1. From the Start menu open the Server Manager dialog.

2. Click Add roles.The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Files Services.

5. Click Next twice.

6. Click the check box next to Windows Search Service.

7. Click Next twice.

8. Click Install.

9. Click Close.

CHAPTER 10  251



Enabling HTML5 Server-Based Search
The following steps show you how to enable HTML5 server-based search. These steps must be
done for each catalog that you are using on the server (or on your local machine, if you are viewing
HTML5 server-based output on your computer for testing purposes).

How to Enable HTML5 Server-Based Search
1. Navigate to the output folder for the HTML5 target on the server or on your local machine.

If you are enabling HTML5 server-based output on your local machine, you can quickly find
the output folder by doing the following.

a. Open the Project Organizer.

b. Double-click the Targets folder.

c. Right-click on the target and select Open Output Folder.

2. In the output folder, double-click the Service folder.

3. Double-click the folder labeled Console.ConfigureSearch.

4. Double-click ConfigureSearch.exe. A window appears very briefly and then disappears.

5. Create a folder called "AutoMergeCache" at the root of the site. Then you must set security
preferences on the AutoMergeCache folder so the application can create and update files.

a. Right-click on the root folder and choose Explore to open Windows Explorer.

b. Right-click on AutoMergeCache and choose Properties.

c. On the Security tab click the Edit button.

d. Click Add.

i. Type Everyone and click Check Names, making sure it gets underlined.

ii. Click OK.

e. Make sure Everyone is highlighted and check the option for Full Control.

f. Click Apply.

g. Click OK to exit the Permission dialog.

h. Click OK to exit the Properties dialog.
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Testing HTML5 Server-Based Search
The following steps are optional for testing HTML5 server-based search (for Microsoft Windows
Search).

How to Test Search
1. In IIS right-click on the directory where your HTML5 project is published to and choose

Explore.

2. In the upper-right corner of the window you will see a Search input box. Perform a search for
a term that is commonly found in your project.

3. If you see results, your project is ready to go live.

What’s Noteworthy?

NOTE If you want to test HTML5 server-based output on your local computer, the
advanced search features of HTML5 are not operable.

NOTE Flare's HTML5 Side and Top Navigation skins do not support runtime project
merging.
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Including Non-XHTML Files in HTML5
Search

Supported In:

When end users perform a search in your online output, you can ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that search. The files do not even need to be linked to any of the
content in your Flare project. This feature is available if you publish HTML5 server-based output to
a web server running Microsoft Internet Information Services (IIS).

How to Include Non-XHTML Files in HTML5
Search

1. Enable HTML5 Server-Based Output If you want to take advantage of the advanced server-
side features of HTML5 (i.e., automatic runtime project merging, server-side search,
searching of non-XHTML files), you must enable HTML5 server-based output. This includes
performing the following tasks: (1) installing Microsoft Internet Information Services (IIS) and
ASP.NET, (2) setting up the HTML5 target and generating/publishing, (3) configuring IIS on
the production server, (4) starting Microsoft Indexing Service or Microsoft Windows Search
(depending on the operating system), and (5) enabling HTML5 search. For more information
see the online Help.

2. Generate HTML5 Server-Based Output In Flare, generate a target using the HTML5 output
format.

3. Publish HTML5 Output to Server Publish the HTML5 server-based output to your Microsoft
IIS Web server.
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4. (Optional) Add IFilter File types that are automatically supported for HTML5 server-based
search include: Microsoft Office files, HTML files, and TXT files. For other non-supported file
types, such as PDF documents, you can download and install a simple IFilter in order to
include that file type in the search. To find and download the IFilter for the file type that you
want to include, go to a website that provides these (such as http://www.ifilter.org) and
follow the instructions for downloading IFilters. You must install the appropriate IFilters on
the server where the output files will be published, and if you are testing HTML5 server-based
output on your computer, you need to install the IFilter(s) locally as well.

5. Copy and Paste Non-XHTML Files to Appropriate Folder Copy all of the non-XHTML files that
you want to be included in the search. Then paste them in the appropriate subfolder of the
HTML5 server-based output that you published. By default, HTML5 server-based will find any
files located in the project output folder, as well as the "AutoSearch" subfolder. Therefore, you
can paste your extra non-XHTML files in the AutoSearch subfolder.

NOTE When you view HTML5 output on your local computer, you need to create a special
folder called "MCPreview" within your "C:\Inetpub\wwwroot" folder. Place a copy of your
HTML5 output files in it. This enables you to test the advanced features of HTML5 on your
local machine. When testing this search feature on your computer, you need to place the
non-XHTML files in the AutoSearch subfolder at this location (as opposed to the output
folder that was generated where your Flare project is located).

NOTE If you are testing HTML5 server-based output on your local machine, you may need
to wait a few minutes after viewing the output for the Indexing Service to fully scan your
files. Otherwise, you may not immediately see the effects of the scan (e.g., searches of
non-XHTML files, incorporation of merged output files) in the output. If you avoid
performing other tasks during this period, the scanning of the files will be completed more
quickly.

NOTE If you want to test HTML5 server-based output on your local computer, the
advanced search features of HTML5 are not operable.
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CHAPTER 11

Synonyms
Supported In:

If users enter search phrases in your online output and those phrases are not returning results, you
can make improvements to your output so that, in the future, users are able to find the search
results they need. One way to enhance your output is to create synonyms for search phrases.

You can determine what search phrases are being used in your output by using MadCap Central
Analytics.

EXAMPLE You view search keyword results from end users and find that many are
entering the search term "sofa." Unfortunately, you have not used that word in your project,
so users are unable to find the topics that they need. However, you have used a similar
word, "couch." Therefore, in the Synonyms Editor, you enter "couch" as a synonym for
"sofa." The next time a reader enters "sofa" as a search keyword, topics containing the word
"couch" will be returned in the results.

NOTE Synonyms are not supported in Elasticsearch.
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NOTE Depending on the browser being used, the cache may need to be cleared in order to
see the synonym results.

NOTE If you create micro content, synonyms can help display the best search results. The
search engine looks at the micro content phrases and alternate phrases that you have
added to a file, but it also considers any relevant synonyms.

This chapter discusses the following:

Adding Synonym Files 258

Creating Synonyms 260

Synonym Group 261

Directional Synonym 262

Exporting Synonyms 264

Opening Synonym Files 265
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Adding Synonym Files
Supported In:

The first step to creating synonyms for enhanced search is to add a synonym file to the Flare
project.

How to Add a Synonym File
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Synonym File.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Synonym File.

The Add File dialog opens.

2. In the File Type field at the top, make sure Synonym File is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare, expand the
Factory Templates folder and click on a template file. If you want to use your own
custom template file, expand the appropriate folder and click on a file. For more
information about templates, see the online Help.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.
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5. In the File Name field, type a new name for the synonym file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The synonym file is added to the Advanced folder in the Project Organizer. The
Synonyms Editor opens to the right.

NOTE If you merge projects, synonym files will remain separate in each project. For
example, if you create synonyms in Project A but not in project B, only the topics from
Project A will use the synonyms when users perform searches in the output.
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Creating Synonyms
Following are steps for creating synonyms.

How to Create Synonyms
1. Do one of the following to add or open a synonym file:

TO ADD A SYNONYM FILE

a. If you have not done so already, add a synonym file to the project. Start by selecting
Project > New > Advanced > Synonym File (if using ribbon view) or Project > Advanced
> Synonym File (if using menu view).

b. Enter a name for the synonym file and click Add.

2. TO OPEN A SYNONYM FILE

a. Open the Project Organizer.

b. Double-click the Advanced folder.

c. Double-click the synonym file.

3. In the Synonyms Editor, you can create directional synonyms or synonym groups for single
words.

NOTE The synonyms feature supports the use of single words only. You cannot use
phrases with the synonyms feature. For example, you cannot create a synonym
named "tool bar" for the word "toolbar." An example of a valid use of the synonyms
feature would be to add the synonym "hound" for the word "dog" or "kitty" for the word
"cat."
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SYNONYM GROUP

This is a collection of synonyms that produces the same search results for all of the words in
the group. It is a useful method if you have multiple terms in your project that are similar, and
you want the same search results to be returned when users enter any of those phrases. In
the Synonyms Editor, you enter the terms with an equal sign between each one
(Synonym1=Synonym2=Synonym3). When users enter any of those terms in future searches,
all topics containing any of those words are found.

EXAMPLE You have written some content about sports, and many of your topics
include the words "sports," "athletics," or "games." If a user enters the word "athletics"
as the search term, it will return not only topics containing that word, but also topics
containing the words "sports" or "games" (even if "athletics" does not occur in those
other topics).

TO CREATE A SYNONYM GROUP

a. Select the Groups tab.

b. Click in the empty Group cell and press F2 on your keyboard.

c. Type the words that you want to include in the group, with an equal sign between each
(e.g., sports=athletics=games). Press ENTER when you are finished.

d. (Optional) Click in the Stem check box if you want Flare to find other variations of the
synonyms that have the same stems.example.

EXAMPLE You enter "hike=walk" in the Group cell. Then you select the Stem
check box. In the future, if users search for the word "hike," it will find all topics
containing the words "hike" or "walk." However, it will also find topics
containing words that have the same stem as those terms, such as "hiked,"
"hiking," or "walking."
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DIRECTIONAL SYNONYM

This is a synonym that works in one direction (Word—>Synonym). It is a useful method if
readers enter a search term that is not contained in your project, but you have a similar word
that is contained in the project. It works like this… In the Synonyms Editor, you enter the word
that is not producing search results (because it is not contained in your project content). Next
to it, you enter a synonym—a word that will produce search results (because it is contained in
your project content). When users enter the original word again in future searches, topics
containing the synonym are found.

EXAMPLE You use Central Analytics to view search keyword results from your users
and find that many are entering the search term "sofa." Unfortunately, you have not
used that word in your project, so users are unable to find the topics that they need.
However, you have used a similar word, "couch." Therefore, in the Synonyms Editor,
you enter "couch" as a synonym for "sofa." The next time a reader enters "sofa" as a
search keyword, topics containing the word "couch" will be returned in the results.
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HOW TO CREATE A DIRECTIONAL SYNONYM

a. Select the Directional tab.

b. Click in the empty Word cell and press F2 on your keyboard.

c. Type the phrase that does not produce search results (e.g., sofa). Press ENTER.

d. Click in the empty Synonym cell and press F2 on your keyboard.

e. Type the parallel search phrase that is contained in the project content (e.g., couch).
Press ENTER when you are finished. In the future, when users perform a search and
enter the term from the Word cell (e.g., sofa), Flare will find all topics that contain the
term that you entered in the Synonym cell (e.g., couch).

f. (Optional) Click in the Stem check box if you want Flare to accept other variations of
the search term that have the same stem.

EXAMPLE You enter "hike" in the Word cell, and you enter "walk" in the
Synonym cell. Then you select the Stem check box. In the future, if users
search for the word "hike," it will find all topics containing the word "walk." The
same will happen if users enter other search phrases with the same stem, such
as "hiked" or "hiking."

4. Click to save your work.
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Exporting Synonyms
IMPORTANT Feedback is deprecated in Flare, which means that it is slated to be removed
in a future version.

After creating synonyms in a Flare project, you may want to export the synonyms file (MCSYNS) to
another location. Those synonyms can then be added to a different Flare project.

How to Export Synonyms
1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the synonym file. The Synonyms Editor opens.

4. Select the File drop-down.

5. Click the down arrow on the Save button.

6. Select Save As or Save To.

7. In the Save As dialog, navigate to the folder where you want to save the exported file. If you
want to add the synonym file to another Flare project, you can navigate to the Project >
Advanced subfolder where that project is stored.

8. In the File name field, enter a name for the synonym file.

9. Click Save.
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Opening Synonym Files
After a synonym file is created, you can open it at any time to make adjustments to it.

How to Open a Synonym File From the Quick
Launch Bar
The Quick Launch bar lets you search for any Flare file or command. It is located in the upper-right
corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any
available results appear in a drop-down list.

2. From the list, click the name of the file.
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How to Open a Synonym File From the Project
Organizer

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the synonym file. The Synonyms Editor opens to the right.
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CHAPTER 12

Including or Excluding Topics in
Search
Supported In:

You can include or exclude a topic when full-text search is generated. If you disable this feature, the
topic is excluded from the search, but it is still included in the generated output.
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How to Include or Exclude Topics in
Search
1. Open the Content Explorer.

2. Locate and click on the topic file.

3. In the local toolbar, click . The Properties dialog for the file opens.

4. Click the Topic Properties tab.

5. Click the check box labeled Include topic when full-text search database is generated.

6. Click OK.

NOTE In Microsoft HTML Help, all topics are always searchable.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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